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Trademarks

CardioComm Solutions  is a trademark of CardioComm Solutions Inc.

Windows" is a trademark of Microsoft Corporation.

Copy and use

Although you are encouraged to make a backup copy of the software for your own use,
you are not allowed to make unlimited copies. The software is protected by the
copyright laws that pertain to computer software. It is illegal to make copies of the
software except for backups. It is illegal to give copies to another person, or to duplicate
the software by any other means, including electronic transmission. The software
contains trade secrets, and in order to protect them, you may not decompile, reverse-
engineer, disassemble, or otherwise reduce the software to human-perceivable form.
You may not modify, adapt, translate, rent, lease, or create derivative works based upon
the software or any part thereof.

Brief
Description

GEMS LITE is a low risk cardiology software database management system. It is
capable of multi-tasking and employs Microsoft tools to facilitate object linking and
embedding of related information into the ECG. The software manages all aspects of a
patient’s cardiology record including arrhythmia diagnosis, pathological diagnosis,
ECG information, doctor’s notes, arrhythmia data and associated reports.

Data can be entered via keyboard, mouse, or serial port, and stored to and retrieved
from all computer media. Information can be displayed on the computer monitor or
printed to a printer.

Intended Use

GEMS LITE is intended to be used as a data management tool for physicians and
cardiac clinics to store, retrieve, communicate and report ECG and ECG data acquired
from a variety of ECG sources including single and multi-lead ECG devices. Users will
be able to purchase specific modules for managing other patient cardiac related data
such as pacemaker and rehabilitation data that fit their patients’ needs. GEMS LITE is
intended for use in clinics, hospitals, physician’s offices, or anywhere a medical doctor
deems appropriate. GEMS LITE does not offer diagnosis or medical alarms.

Information in this manual is subject to change without notice and does not represent a commitment on
the part of the vendor. The software described in this manual is furnished under a license agreement and
may be used only in accordance with the terms of that agreement.
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GEMS Software
License Agreement

Serial Number

Important:

By operating GEMS Lite software on a computer, you acknowledge that you have accepted the terms of this license.

Definitions:

“Software” means the full system, including computer programs and codes, techniques, tools, formats, designs, concepts, and methods,
together with any updates subsequently supplied by CardioComm Solutions.

“Software Copies” means copies of all or any portion of the Software, including backups, and duplicates.

“Related Materials” means all of the printed materials provided in this package or later supplied by CardioComm Solutions for use with the
Software.

“Package” means the Software and Related Materials.

Permitted Uses:

CardioComm Solutions grants you a non-exclusive license to use the Package according to the terms set forth below. Under this license
you may:

e Use the Software on a single computer in accordance with the software copy protection employed by the program;
e Use the remainder of the Package in accordance with this agreement;

¢  Copy the Software for backup purposes only as long as you keep in your possession and do not permit to be copied all such Software
Copies.

Prohibited Uses:
Under this license you may not:
e Lend, license, rent or otherwise transfer the Package or any of its parts or copies, or your rights to the Package;
e Translate, decompile or otherwise reverse engineer the Software, or convert the Software into another programming language;
e Use the Software on more than one computer at one time;
e Make copies of the Package or any of its parts except as permitted above;
e  Remove or obscure the CardioComm Solutions copyright and notices.

In addition, you agree to make reasonable efforts to protect the Package from unauthorized use, reproduction and distribution.

Duration:

This license and agreement is effective from the day you operate the GEMS Lite software, and continues indefinitely, or until you return
the package and all copies of the Package and its parts to CardioComm Solutions. If you breach this agreement, CardioComm Solutions
can terminate this license by notifying you in writing. You will then be required to return the Package and all copies thereof. CardioComm
Solutions may also have other legal rights which it may wish to enforce against you.
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Limited Warranty

CardioComm Solutions warrants that upon delivery to you, the Software and its distribution media will be free from defect in
materials and workmanship and will substantially conform to the specification set forth by CardioComm Solutions.
Significant errors in the Software which make it unusable are covered under this limited warranty for 60 days from the date
of delivery of the Package to your address. CardioComm Solutions will correct or help you avoid errors with efforts we
believe suitable to the problem. This warranty does not cover material or data that has been lost, stolen or damaged by
accident, misuse or unauthorized modification. CardioComm Solutions makes no other warranty, express or implied, to you
or any other person or entity. Specifically, we make no warranty of merchantability or that the Software is fit for a particular
purpose. CardioComm Solutions is not liable for special or incidental damages, even if we or our agent(s) have been advised
of the possibility of such damages. CardioComm Solutions is not liable for damages or costs incurred as the result of loss of
time, loss of data, loss of profits or revenue, or loss of the use of the Software. In addition, we are not responsible or liable for
damages or costs incurred in connection with obtaining substitute software, claims by others, inconveniences or similar costs.
In no event will our liability for any damages to your or any other person ever exceed the price paid for the license to use the
Package, regardless of any form of the claim. CardioComm Solutions believes that the information contained in the Related
Materials is correct. However, CardioComm Solutions does not assume responsibility for the accuracy of the content of the
manual nor use of the manual. CardioComm Solutions further reserves the right to revise update or change any part of the
Package without a direct or inferred obligation to notify any person of such revision, updates or changes.

Miscellaneous
This license agreement shall be construed under and governed by the laws of the Province of British Columbia and Canada.

In the event that one or more of the provisions or parts of any provision contained in this agreement shall for any reason be
held to be invalid, illegal, void or otherwise unenforceable in any respect by a court of competent jurisdiction, the same shall
not invalidate or otherwise affect any other provision herein.

This agreement is the entire understanding and agreement regarding the Package, and supersedes any prior oral or written
communications. This agreement may be modified in a written amendment signed by an authorized CardioComm Solutions
officer. You acknowledge, by operating the GEMS Lite system for the first time that you have accepted the terms of this
agreement.

No part of this Package may be reproduced, transcribed or translated into any language without the prior written permission
of CardioComm Solutions Inc.

CAUTION: U.S. Federal Law restricts this device to sale by or on the order of a physician (or properly licensed
practitioner).
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Introduction

GEMS Lite is the simplest answer to ECG acquisition and
patient data management in the field of arrhythmia, 12-
lead and TTM Pacing ECG management.
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10 OIntroduction

Visual task instructions

We want this manual to serve you in your day to day
work, especially during the steepest part of your learning
curve. We hope it becomes dog-eared and coffee-stained
— because a manual that’s crisp and clean is a manual that
nobody has used.

To gain as many coffee stains as possible, we’ve written
and laid out this manual using two principles:

*  Visual: At every step of every procedure, this manual
shows you exactly what you will see on screen and
what you should do with it.

e Task instructions: Each set of instructions in this
manual describes one of the most common or
important tasks that users of GEMS Lite need to do.
The instructions are focused on your everyday
activities.

Additional Reference material documenting all features
of the software is in the GEMS Lite Online Help.

If there’s some way you think we can improve the
usefulness of this manual, please drop us a line at:

CardioComm Solutions Inc.
Address:

201 - 3060 Cedar Hill Road
Victoria, B.C., Canada

V8T 3J5

Email:
support@cardiocomm.com
Website:
www.cardiocomm.com

Tech Support:

Toll free 1-877-744-1122  Help Desk: press 3
Urgent: press 1

Toll 1-250-744-1822  Help Desk: press 3
Urgent: press 1

GEMS Lite

Manual Revision Date: 29-Nov-04



Regulatory Notices [111

Regulatory Notices

c € Notice (European Union)

Marking by the CE symbol indicates compliance to Medical Devices Directive 93/42/EEC.

A "Declaration of Conformity" in accordance with the directives has been made and is on file with the Authorized
Representative: RMS - UK Limited, 28 Trinity Road, Nailsea, Somerset, BS484NU England.
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Installing GEMS Lite

Computer requirements — minimum

GEMS Lite is designed for a PC with the following
minimum requirements:

Windows XP, or

Windows 2000 (Service Pack 2 or higher,
Recommended.: Service Pack 4), or
Windows NT 4 (Service Pack 6), or
Windows 98

Internet Explorer 5.5 (Internet Explorer 5.0 required
for PCs running Windows 98)

Computer requirements — recommended

GEMS Lite will work better on a PC with the following
recommended requirements

Windows XP

Windows 2000 (Service Pack 2 or higher,
Recommended.: Service Pack 4)

Internet Explorer 5.5 (Internet Explorer 5.0 required
for PCs running Windows 98)

Pentium II 500
128 MB Ram

50 MB free space on Hard Drive for application
install

100 MB free space on Hard Drive for Database and
ECG storage

CD Rom drive

Sound Blaster 16 sound card
(must be a separate sound card, cannot be integrated)

56K Modem or Internet Access

Pentium III 500
256 MB Ram

100 MB free space on Hard Drive for application
install

1 GB free space on Hard Drive for Database and
ECQG storage

CD Rom drive

Sound Blaster Live Value sound card
(must be a separate sound card, cannot be integrated)

56K Modem or Internet Access

GEMS Lite
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Database Management

WARNING: Reinstalling or uninstalling GEMS Lite can delete your database!

You must back up your database before you uninstall
or reinstall GEMS Lite (using the Add/Remove
Programs utility in Windows, or by starting the Setup
procedure from the GEMS Lite installation CD).

Uninstalling or reinstalling GEMS Lite will remove
your database. If you have a copy of your database, you
can copy it back to your computer to restore your data
following reinstallation. If you do not have a copy, there
is no way to recover your lost data except by re-entering it
(very tiresome!).

Upgrading GEMS Lite will automatically convert your
existing database. When upgrading it is always a good
idea to make a copy of your data before.

To back up your database:

1. Shut down GEMS Lite if it is currently running.

2. Copy the file
“C:\Program Files\GEMS\GEMS Lite.mdb” into
another folder on your computer or on another
computer on your LAN.

To restore your database after reinstallation:

1. Do not add information (patient records, ECGs, etc.)
to the GEMS Lite database before you complete the
next step.

2. Copy the backup copy of the file “GEMS Lite.mdb”
(see backup instructions above) into the folder
“C:\Program Files\GEMS”.

3. Start GEMS Lite.

Manual Revision Date: 29-Nov-04
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Backups

The data in your GEMS Lite database is vulnerable — to
human error, to equipment breakdowns, to natural
disasters and to deliberate tampering or damage. You
must institute regular backups to provide a means to
recover should your database suffer damage or outright
loss. Backing up your database means making and
keeping a copy of it on a regular basis. For any but the
least demanding uses of GEMS Lite, this means daily
backups.

Data backups can be made on floppy disks, on tapes, or
on another computer on your network. The important
thing about the medium chosen (disk, tape, other
removable medium, or other computer) is that it is distant
from or can be moved away from the computer whose
data is being backed up. Backups should be stored in a
physically separate location so that thefts and natural
disasters are less likely to wipe out your backups as well
as your working copy.

There are several commercial backup programs available
that let you perform regular backups easily and
automatically. For example, Windows includes a standard
provision for backup procedures. There are also
independent products that perform backup services, and
there are companies that provide backup services over the
Internet.

If your workplace has a Systems, Network, or Database
Administrator, inquire about the backup procedures in
place, and make sure that your databases are part of them.
If no one is currently responsible for backups, then you
must take steps to implement them. (Caution: It is
tempting just to take copies of your database every so
often, but a casual approach to backing up data always
leads to problems. It's very easy to forget — and that's just
the time disaster chooses to strike.)

GEMS Lite
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Installing GEMS Lite
Please read the WARNING above before you reinstall GEMS Lite.
1. Shut down all applications

1.1. Shut down all applications currently
running on your computer.

2. Install GEMS Lite

2.1. Place the GEMS Lite installation CD in

your computer’s CD-ROM drive. e oy

U Installation procedure should
automatically start. Ifl.t does not, use i&b;l;b;;?;l:;|sPT;|§:|mg‘tlheInslal\ShleIdW\zald which wil guide you thiough the rest of
Windows Explorer to browse to the CD-
ROM drive and double-click on Setup.exe.

» GEMS Lite logo appears.

» InstallShield Wizard initialization dialog

Flease wait while the InstallShield Wizard prepares the setup.

appears.
IzstallShield
» Welcome page of the Wizard appears. x|

O  Each page of the InstallShield Wizard
guides you through one step of the
installation process. At the bottom right of
each Wizard page there are three buttons.
<Back, Next>, and Cancel. These buttons,
respectively, allow you to back up a page,
go on to the next page, or cancel the entire
installation process.

‘Welcome to the InstallShield Wizard for GEMS
Lite

The InstallS hisld® Wizard will install GEMS Lite on your
computer. To continue, click MNext.

< Back SMest> I Cancel

//
2.2. Click Next>.
» Software License Agreement page of the [=]
. License Agreement ‘ A
Wizard appears. Please read the follawing license agresment carsfully iﬁ_ il
Press the PAGE DOWN key to ses the rest of the agreement
Saftware License Agreement ﬁ!

CardiaComm Solutions Inc. is willing to license the enclosed software to licenses only on
the condition that licensee accepts all of the

following terms. Licensee must read the terms of this agreement carefully. By accepting
belows, by making praductive use of the software

of by registering the software, licenses agrees to be bound by this agreement. If licensee
does not agree with the terms of this license,

CardioComm Solutions Inc. iz unwiling to license the software to the licenzee and licenses
rust immadiately return the softwars |
Do you accept all the terms of the preceding License Agreement? If you select No, the setup
will close. To install GEMS Lite, pou must accept this agreement.

InstaliShield

<Back e | Ho
/

2.3. If you agree to the conditions of the
software license agreement, click Yes.
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2.5.

2.6.

» Choose Destination Location page of the

2.7.

2.8.

Customer Information page of the Wizard
appears.

Enter your customer information.

If the product you have is a demo product
type DEMO. If the product is a full version
type in the key ID on the back of the CD or
on the Security Key.

GEMS Lite Setup ]

Customer Information

Please srter your information

Please ntst your rams, compary snd the nine character serisl number. The serisl
number can be found on the white label of the hardware key in the farmat of
CCSHERHHE. For demonstration versions please enter Demo,

User Mame:

o Mame

Company Mame:

[ou Company

Serial Number,

|

InstallGHield

< Back I | MNest> I Cancel
/

/

Click Next>.

Language Selection page of the Wizard
appears.

Click Next>.

LEMS Lite Setup

Language Selection

Please check the box beside the desited language.

InstallGHisld

<Back | News | Cancel

/

Wizard appears.

Click Next>.

Choose Destination Location
Select folder where setup will install files.

Setup will install GEMS Lite in the following falder.

Toinstall to this folder, click Next. To install to a different folder, click Browse and select
another folder.

C:\Program Files\GEMS Erowse...

IstalShield

"Destmallon Folder

<Back Newts | Cancel |
/

/

Select Program Folder page of the Wizard

appears.
On this page you choose the name of the
Start Program folder in which the
components of the GEMS Lite application
will be grouped under. You should accept
the default, GEMS Lite, unless you have a
good reason for choosing another name.

Click Next>.

Select Program Folder
Please select a program folder,

Setup will add program icans to the Program Folder listed below. You may type & new folder
name, or select one from the existing folders list. Click Mext to continue,

Program Faolders:

Esisting Folders:
3Com HomeCornec

Administrative Tooks

Adobe Acrabat 4.0

ASLIS Utility

Dislogic System Software
lean Snatcher

Intel Ultra ATA, Storage Driver

Macromedia Disamweaver 3 =l

I st Ghield

<Back [ Nets | Concel |
/

/

GEMS Lite
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» Start Copying Files page of the Wizard
appears.

GEMS Lite Setup x|

Start Copying Files m

Setup ks enough information to start copying the progiam fles. 1f pou want ta review ar
change any settings, click Back. If you are satisfied with the settings, click Mext to beain
copying files,

Fieview settings befors copying fles

Cunent Settings:

Customer Information -
User Name: Your Name
Company Mame: Your Company
Serial Mumber: CC5000124

Language Information

Language: English
County: United States

Destination Lacation: =
4 12

<Back [ MNews | Cancel |
7
2.9. Click Next>. /
» InstallShield begins installing the GEMS — G k|

Lite application on your computer.

O Depending on the speed of your computer,
it can take up to several minutes to load
and install all the files. An indicator shows
the progress of installation activities.

» Setup Complete page of the Installation
Wizard appears.

Selup Status m

GEMS Lite Setup is performing the requested aperations

Irestalling

C:4Pragram Files\GEM S etd0SPE WK exe

I T

InstalGhield

Cancel

GEMS Lite Setup B

Install5 hield Wizard Complete

Setup has finished installing GEMS Lite on your computer

cBack [, Awish | | Cancel
/

/

2.10. Click Finish.
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Finding your way around GEMS L.ite

This chapter is a primer on the names of things in GEMS * Adding a Logo to Reports
Lite and their basic uses. It describes: . .
*  Searching for a Patient

*  Basic parts of GEMS Lite. ) . .
*  Searching and Deleting a Physician
* Reviewing GEMS Lite Options.
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20 OFinding your way around GEMS Lite

Parts of GEMS Lite
1. Guide to parts of the GEMS Lite main window

1.1. Title bar -
» Displays file name of database in use. 7w GEMS Lite - C:\WProgram FilesyGEMSAMGEMS Lite.mo

1.2. Menu bar File Edit Mew Tools Help

» Contains menu commands for every
function in the product.

1.3. Patient List Patient Mame | Patientip | DB | Gerder | Group | status | Address | Phane
. . Appleby, Sarah 262342 6/6/15945  Female Pacemaker  Active 4324 Peach Street, Dakland, California, 435.. 3435324
} COI’ltall’lS all patlents that have been Braven, Bobhy 53243 70841955 Male Anbythmia  Active 432 Fort Sheet, Philadelphia, Pernsybearia, .. 534 5234
t d . t h GEMS L t d t b Hallywell, Holly 34543 E/6/1976  Female Arhythmia Active 234 Richmond Road, Washington, District 0. 345 345
Miliken, Tracy 23432 4/6/1964  Female Pacemaker  Active 2343 Raven'Way, Las Yegas, Nevada, 234, 3435234
entered mto t € 1€ database. Parker, Rarnly 5623432 3541966 Male Arthythmia Active Tacoma, ‘Washington, 32432, Urited States 3456345
Salermy. Sarah THAEE 3/5/1955  Female 12-Lead Active B435 Randy Street, Jackson, Mississippi, 3. 463 3243
Thompson, Tery 2323423 4/4/1934  Male Arhythmia Active 5345 Walter Street, Salem, Massachusetts,.. 3436323
falters  wally 235235 2/4/1966  Male Pacemaker Active 3423 Fancy Street, Kansas City, Kansas, 43 342 6453
“weatherby, ‘Wima 52423 5/6/1934  Femals 12-Lead Active 3245 Small Vine \way, Baltimors, Manand, ... 532 3454
“rander, Heriy 36345 E/3/1964  Male 12lead Active 345 ellow Street, Washington, Distict of C... 234 5345

1.4. ECG List
» Displays all ECGs for the selected
Patient. Two tabs display the two types of
ECGs — Arrhythmia/12 Lead ECGs or
TTM Pacing ECGs.

TTM Pacing ECGs @Anhymm\anz Lead ECGs

Type | Transmit Dats | Patient Name | Recorded Date Sitatus EditIntisls Fceived | A
Event -1 Chaninel - [Manual] 12/9/2002 03:13:34 PM Braven, Bobby 11/19/2002 02:57:45 P Mot Edited

Event -1 Channel - [Manual] 12/9/20020319:34 PM  Braven, Bobby 11/419/2002 02:53:33 PM Not Edited

Main - 1 Channel - [Marnual] 12/9/200203:24:14 PM  Braven, Bobby 12/9/2002 03:24:14 PM Nat Edited Joshua

Event - 3 Chaninel - [Manual] 12/9/2002 03:24:14 PM Braven, Bobhy 9/26/2002 02:57:01 P Mot Edited

Event - 3 Channel - [Manual] 12/9/2002 032414 PM  Braven, Bobby 9/25/2002 02:43:52 PM Not Edited
tain - 12 Lead 12/9/2002 03:26:21 PM  Braven, Bobby 12/9/2002 03:26:21 PM Not Edited doshua
< | >
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GEMS Lite Options

O Options in GEMS Lite are set using the Options form shown below.

1. Setting Options.

1.1.
4

1.3.

1.4.

1.5.

1.6.

Click Tools Menu and select Options.
Options screen appears.

ECG Warehouse field displays the
location where the ECGs are stored and is
automatically selected to the computer
name that has been installed. The default

setting is [COMPUTER NAME], LOCAL.

If this box is empty click Change
and select Local.

Note: Changing the ECG Warehouse may
cause connection problems.

Arrhythmia/12 Lead and TTM Pacing-é

boxes display the currently selected device
drivers. The defaults should be left unless
otherwise instructed.

File Edit MNew Help

Fatient Mame Options

=, Options

a

e | Help

ECG ‘W arehouse:

|SEF!.|’-\F'F’Y,LD CaL

v Compress ECGs

Arthythmia 2 Lead: |Frequenc:_l,l Demodulator Driver

TTH Pacing: |Ean_l,l-AII Demaodulator Driver

Header

Company:
Street:
City: /

Header and Logo ficlds allow for a
custom logo to be typed in and loaded into
GEMS Lite. See next section.

Do not display deceased patients — when —____

/

checked patients with status “Deceased”
are not displayed in the patient list.

These patients are not deleted when this
preference is selected they are just not
viewable in the patient list. Uncheck to
make patients with this status viewable.

Do not display inactive patients — when
checked patients with status “Inactive” are
not displayed in the patient list.

These patients are not deleted when this
preference is selected they are just not
viewable in the patient list. Uncheck to
make patients with this status viewable.

State:

Logo:

Change
Change...

Country: |

ZIP Code:

™ Donat dizplay deceased patients
™ Do not dizplay inactive patients

Load...

Apply

LCancel |
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2. Adding a logo to reports.

2.1. The fields under Header can be used for a = Options )
text information header on reports. 7 [ Helo
. . . ECG WWarehouse:
2.2. Using the graphics program of your choice, [FCRAPFY LOCAL
save your logo image to disk in Windows ¥ Compress ECGs
" .
Metaﬁle ( -Wmf) format ora Wlndows Anhpthmiad12 Lead: ‘Frequancy Demodulatar Driver Change
Bitmap (*bmp) TTH Pasing [Cany Al Demodulter Difver Change

\Eader

Copary | =
Street [
ity r
State [

County: | [
ZIP Code: Load.. | pew. | \
[ ———— ool / ® | el |
/
2.3. On the Options screen /
click New....
» Open dialog appears. Doen 2lx|

P e H o emom-

2.4. Navigate to folder you saved your logo
image file in.

2.5. Click on logo image file.

File name JLogo =l Open
Files of ype: ~ [\windows Metafile [~ wif] = | Cancel
I~ Open as read-orly
) 4
2.6. Click Open. /
» Open dialog closes.
x|
> A form appears to enter the name of the Please enter a name for the loga file:
logo template file that was created. Enter Cancel |
the name of the logo file and click OK.
N
» Logo image appears in Logo preview area
on the Options screen. / IE:\Program Filesh\GEMS\LiteT emplates\Dermo L
» Logo filename appears in textbox below Load.. Save

Logo preview area on the Options screen.

2.7. Click OK.
» Options form closes.
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Searching and Deleting Records
3. Searching and deleting a patient.

3.1.

The main GEMS Lite screen displays a

constant list of all patients in the GEMS
Lite database. Patisnt Name Patient ID DOB I 5 New Patient E\_
. 7. £opty Saeh e SO 1. Demoaraphics } 2 Monitoring Information | 3 Associations | §§§3
O  Clicking on the column headers sorts the et ot = | £ 2 R
patient list according to the data in that Pater Rty S wsnoss | Poventin: | s |E =
Salemmy, Sarah TEAEE /541955 Last Name: | First Name: | 3243
column. ithag g Tom penee | wee | e B
.. Yy . Weatherby, Wima 52423 /641934 3454
O There are no additional search capabilities Vo Hony EEEI R } Bt Date ; N
. . . . 55N, Gender. -
in GEMS Lite other than the main patient I e
llSt' Shrest [
[
City [ | State: [ |
2P Code: | County: | |
Description; Phone Number. Extension:
Phone: | =] [
3.2. To edit a patient record: pataton Rpermseraimizcn] | o } = [
1 1 > 1 e ransmit Date E-Mait [
3'2‘ l - Clle on the I:)a'tlerlt S name 1n the ET\sffnlﬂ Channel - [Manual] | IZ/E/ZE:E?ZE‘IEWS“F’
patient list. AR el e e et N b e L
Event-3Channel - [Marusl]  12/3/2002022404 P Ethriciy: | ~| Group [ ~|
. Event - 3 Channel - [Marual] 12/9/2002 03:24:14 PH . § §
3.2.2. Choose Selected Patient from the S [RERlRE || FRED b
Edit menu.
» The Patient form appears. ¥ et S J|L_EEE
s Double clicking on the patient name
also opens the Patient form.
s GEMS Lite - C:Program Files®
3.3. To delete a patient record: Filz | Edit Mew Todls Help
. ., . Pa  Selected Patient
3.3.1. Cllf:k 0? the patient’s name in the -
patient list. Physicians
3.3.2. Choose Delete Selected Patient Delste Selecked Patient
from the Edit menu. Delete Selected ECG
» A confirmation screen appears.
% Using the Delete key on the
keyboard will delete as well.
s Once a record is deleted there is
no way to retrieve it.
O To minimize the size of the patient list, use
the “Do not display deceased/inactive
patients” options on the GEMS Lite
Options (page 19).
O To Change patient status see Adding a
New Patient on Page 24.
Manual Revision Date: 29-Nov-04 GEMS Lite
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4. Searching and deleting a physician. |

GEMS Lite - C:%Program F
Filz | Edit Mew Tools Help

4.1. From the Edit menu on the main screen
choose Physicians
» A screen appears with a list of Physicians
that have been entered into the GEMS Lite

Selected Patient
Selected ECG
Phiysicians

Pa

Edit Physician
File Edit Mew Help

Physician Mame | Address

| Specialty | Group | Phaone |

database. Flanded, Dr. andy 34Peach.. Cardiologst Al 756 7455
N L. e Smithzon, Dir. Sally 345%/al..  Cardiologist Al 345 3634
s There are no additional search capabilities Thomsan, Dr. Tery 534'west . Cardidlogist Al 453 6345
. . . “whhite, Dir. \wally 3432 6th... General ... all 645 3454
in GEMS Lite other than the main YYandel, Dr. Sam 3432 4th . General. Al 3437342

physician list.

4.2. To edit a physician record: A
4.2.1. Click on the physician’s name in Cadlog =
the physlclan 1lst' Last Name: |Thamson First Name: |Teny
Micdle T o
4.2.2. Choose Edit Item from the Edit 2‘::’8‘; e Phys.Code: [

menu.

le | Edit Mew Help [

» The Physician form appears. oy [Prisdephia =] St [Femegrora =]

o I .. Edit Ttem 2PCode [ Counm Urited States -
“* Double CIZCklng on the phySZClan Delete Ikem Description: Phane Number. Extensian:
name also opens Physician form. Phore:  [wark B EEE
| =) | [
Fax, |
4.3. To delete a physician record: Ethat : .
Group: Al i
4.3.1. Select physician’s name in the
PhySCian’S list. ¥ Ciose On 0K ok | concel | Hep |
4.3.2. Choose Delete Item from the
Edit Menu.

» A confirmation prompt will appear.

*»  Using the Delete key on the
keyboard will delete as well.

s Once a record is deleted there is no
way to retrieve it.
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Gems Lite Scheduler

1. Accessing the GEMS Lite Scheduter.

O The GEMS Scheduler Lite is a tool for
managing schedules for Arrhythmia and
TTM follow-ups. The scheduler is
equivalent to a traditional appointment
ledger. You get the familiar look and feel
of an appointment book and the convenient
features of a centralized database for
managing all appointments.

B CardioComm GEMS g [ GEMS Lite

1.1. Scheduler Lite is available as an upgrade Beadbcannen » T¥] GEMS Lite User Manual
& sScheduler Lite

for existing customers or as optional
module for new customers. Contact your
distributor for details on how to upgrade to
GEMS Lite with Scheduler.

1.2. To launch Scheduler Lite

1.2.1. Open the Windows Start Menu, _ ‘ S —
A & GEMS Scheduler - C:\Program Files\GEMS) LiteDataba M5 Liteimdb =of x|
select the CardioComm GEMS E——
folder.

1.2.2. Select Scheduler Lite.
» The Scheduler Lite application
opens.

December 4, 2003 » || Unscheduled Appointment
(0000222) Bob Baker - Anhythmia E

[ T2 b aken - BTt
TO000TT1] Abel Adler - TTH Pacing ECG i fiokcEl

~—

1.3. For detailed instructions on how to use
the GEMS Lite scheduler:

1.3.1. Consult the GEMS Lite Online
Help.

[ TAO00222] Bob Baker - Arhythmia Follom-up

&

3 dppointments
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Arrhythmia Management / Event Monitoring

This chapter describes some of the main tasks associated

with event monitoring in GEMS Lite. They are:

Step 1 — Add a New Patient or
Physician

Step 2 — Associate a Physician
Step 3 - Receive ECG transmission
Step 4 -7 - Review and Edit ECG
Step 8 - Print a Report

GEMS Lite

Manual Rev. 1.0 / 29-Nov-2004
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Add New Patient or Physician

Create new patient or ph

1 New Patient E‘
1, Demogiaphics | 2 Moriaring Infamation | 3 Ascociations |
1.1.  From the New menu choose Patient or . | s 7}““““ =l
Physician. Middle: [ Tile: [
» New Patient or Physician dialog opens at o o | .
Demographics tab. b | s |
Stieet: [
[
City [ | state [ =
ZIF Code: | Count: | |
Description: Phone Number: Extension:
Phone: [ I [
[ =) [
1.2. Fill in demographics information. o ‘% -
. . . 1 New Patient |
U Fields labelled in boldface must be filled in g [ oot 2 ko g 3 s B
(Patient ID, Last Name, First Name). Bt [ | AT
i } . - elect o type information, &&lect &ppend bulton to a
O The patient status is set to Active upon L _ | [ |
entering a new patient. The Status can be S %ﬁﬁ@”ﬁ'ﬁﬁ?ﬁﬁ?é‘ﬁfﬁﬁ
changed to Inactive or Deceased after the _ I
patient has been created.
O A patient may be removed from the patient
list when the patient status is changed if
the preference is set under the Tools >
Options to ‘Do not display Deceased
Patients’ or ‘Do not display Inactive
Patients’. See page 19.
1.3. Click Monitoring Info tab.
U This is a free text field that prints on the
. . . ¥ Close On 0K | 3 ancel =l
Patient Transmission Event Recorder Y ol Lo |_ B

report. This field should be used for
information such as Device loaned,
symptoms, efc.

U  The New Physician record only has a
Comments tab available.
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2. Associate patient and physician

2.1. Click Add on the Associations tab.

f| New Patient

» Save Patient dialog opens if the patient 1 Dongahics\ 2 Henlotrs omaln 3 Aseters
hasn’t been previously saved. Nare  [Toe [ Associaion
Save Patient
@ Add Patient record to the database?
22. Click OK. e
» Save Patient dialog closes.
» Select Physician dialog opens.

2.3. Find and select physician.

2.3.1. Click Fill List. i fesosiaion Physeion
» List fills with physician names. |—_[Sf|ﬁhihm'a: = \ Hilis | g e
2.3.2. Click on physician’s name. “ Lagses ] 5"“””" [ Prore | e
Association: [General Practitioner =] — Beceives
24. Select Association type. ——— — s
O  The default association is Follow-up. The Woosseonok dew [ [ o | conca | s
physician with the association type Follow-
up will print on the report. Additional
physicians can be added but only the
Follow-up physician will print on the
report.
U A4 New Physician record can be entered §,_{1) Edit Patient -t t =

here as Well by Cllcklng the New button 1. Demuglaphicsl 2. Monitaring Infarpation 3. Associations

Aszzociation

2.5. Click OK.
» Association Physician dialog closes.

» New association apg_" I
Associations tab.

Add | LDielste | Change |

¥ Close On 0K ok I Cancel | Help |
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Receive ECG

3. Receive patient call and record ECG transmission

| Poieri | DOB | Gender | Brop | Seshur | Addvess | Phore |
222 BIHE  Famde Potensker  Adtve 4324 Paach Stest. Osbland. Callomea, 425 HISIM
sne TRNES Maln Pargthenan Azt 410 Fod Sweel, Phiadelphin. Pennmybvanes, 534 5204
HHT R Femsle Aarkgthiria Active M Fichesond Alosd. Wathington. Distct 6. M5 645
. . . ur AT e Facrmakr i i'.u'JHmW!w.lm\‘lvﬂl Mevada 74 HITTH
3.1. Select Patient name from the patient list. e W M s B T g A
20U AT Make Arhythmia Active M5 ‘Waber Sheet. Salem. Massachuretts IS
285 S M Foammshm fuctrem MR Stoemt, Kanas City, Karnas 43 MIRAN3
L SENTU  Femse 12leed Artve 25 Sl Views 'Woaw, B alemore, M, L 532 5L
B B Mae 12esd fetre 345 Velow Stmet. Washington. Ditict of € MGG
. .
3.2. Click New Arrhythmia/12 Lead ECG
from the New Menu.
» New Arrhythmia ECG dial k™ i
ew Arrhythmia ialog opens.
| Trasvarr Dt | Patiert Hirn | Riscorded Dsie | Sastuz | Bkl | Ricived | =
Everd - 1 Chanrel - Marnaal] VAR 1R P Brwen, Hobby AR (5 45 P Mol Eclbedd
Event - 1 Channel - (Marual] 12200 01X M P Biaven. Bobby 11492002 0253 XIPM Mot Edeed
Mo - 1 Charrosl - (Marusal] 1D R PN furen Robby 122 ORI 14PN Mot Edted Jomhuy
Evend - 3 Charewl 124972002 032414 P Braven, Bobly Q52E72002 (25701 P Mot Edeed
Fu—i-]ﬁmﬂ-?ﬂmuﬂ 12000 O 2414 P Riwwnn Robty QIE000 (0 4550 P Mol F ched
Man 12 Losd TWROIXD P Braven, Bobby 1202002 0X 521 PM Mot Edeed Joshus ¥
4 »

& (0] Arrhythmia ECG - Braven, Bobby - Not Edited

1. Receiving | 2. Editing I 3. Options |

Date/Time: |Feb-D1 -2000 09:30:23

Receiving Tech: |KR

=l

3'3° SeleCt a Description for the ECG Description: IHoutine Tranzmission LI

3.4. Select Symptoms, Activity, and Location Symptoms:  |Dizziness =l

items based on patient’s description. Activiy:  [walking =]

. . . ocation: ficild -

3.5. To view or change the patient record, click roes e =
Patient....

—~ Patient... | : il I LCancel Apply | Help |

3.6. Click OK.

» ECG Viewer opens in new window.

MS Lite - C:\Program Files\GEMS\GEMS Lite.mdb

= New Arrhythmia ECG - Appleby, Sarah

port Tools  Help

- [B]x]
[ [Elx]

One Strip

=l ~l[zsmme ~[[romminy ~[none ][40z ;jEﬁAIJ 'TME_!L!.!M

bampling Rate: 1005ps

Click Start Recording.

O To ensure all FSKs are recorded, be sure
to click Start Recording before the patient
starts sending the ECG from their device.

» Recording indicator appears.

‘atient: Appleby, Sarah Date: 1201142002

Time: 3:22:10 FM

Duration: 00:00,34”
] ] || [RECORDING

Recording

|
 Eans

GEMS Lite

Manual Revision Date: 29-Nov-04



Receive ECG 031

3.8. Ask patient to begin sending ECG.
» ECG is displayed as it comes in.

3.9. Configure Device — This button is
available to change the device driver when
different event recorder types are being
used. Click on the button and choose the
type of device from the Demodulator list.

3.10. When the patient’s ECG recording has

fon GEMS Lite - C:\Program Files\GEMS\GEMS Lite.mdb

®a New Arrhythmia ECG - Appleby, Sarah

File _Report Todls Help
One Strip = e = |[1ommmy v ]|none < |la0Hz jfﬁﬂ lb_ll . I,l l"m @
Patiert: Applehy, Sarah Dete: 1271172002 Time: 3:22:10 PM Duration: 00:00:00 | Sempir§ Rate: 100sps
|
[
m———r 5 B =
Relative Pawer ag the triangle to set the threshold,
ooo

finished playing back, click Stop
Recording.

1 Pacetrak Flus

T King of Hearts 3000E~

w1 New Arrhythmia ECG - Braven, Bobby

OHz 4000 Hz

Demodulatar: |King Of Hearts =
4 Braemar ER 300 -

:Braemar ER PO
Pacetrak

I Invert Signal

:I Eancall Apply |

Heart Aide EZD
Hea A EZfEZ-F'Isj

File Report Tooks Hel
One Strip i =] fzsmms wlfrommimy ~][none ][40z j]@_l‘-) M Wl £l Tle< B _Eﬂ
gtient: Braven, Bobby Deate: 12/10/2002 !T\me 11:39:43 AM bur fion: 00:01:04 Eampling Rate: 250sps
Al
» Recording indicator disappears. |
L L |
» New ECG record is displayed in window. |
» ECG Viewer displays ECG Editing —~
|ctivation|
controls. | : ; il
| I { ﬂ i I
. . = el I 8 W WO A T B | W o v, ) v e
» Terminate patient call.
CHI «
< il il7
00001050 4 |» 00:00:19 B8
GEMS Lite
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Review and Edit ECG

U Ifthe ECG transmission you recorded contains multiple events, it is split into separate “Event”
ECGs that are listed as subsidiaries to the recorded Main ECG. You should sample and measure
each Event ECG, not the ‘Main’ ECG.

4. Sample ECG.

4.1. With an ‘Event’ type ECG open.

Click Sample.
» Pointer changes to g:{:
4.2. Point at the beginning of desired portion of [T EEE
ECG trace and click on it. : |
. One Strip A lfsmmis frommmy <|fiore <lson <[BH T| % QUL 2| T(3<| 8] E|
} A 8-S€COI1d sample, beglnnmg Where you Patiert: Braven, Bobly Diate: 11/19i2002 Time: 2:57:34 P Duration: 00:00:18 Sampling Rate: 250sps
clicked, is created. The sampled part of the E
trace changes colour.
» Sample options menu appears.
4.3. Choose a sample option: f
4.3.1. To make the sample longer, et 2 Tow v 81465734 2002 : ‘ , A
click 8sec, 16sec, 24sec, etc. et e o M M
24 sec
4.3.2. TQ place a label on th§ sample, —
click one of the selections or to 0 ser
s Sample ECG
have no label, click No label. \ o s gt
: : : Wentricular Arrhythmia
» Size or label applied accordingly. s e
Sinus Bradycardia
Atrial Fibrillation
Pause CHT ~
< ST Change >
Mo label 0O00:0000 4 (00000918
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5. Take measurements.

5.1.

5.2.
5.3.

5.4.

5.5.

5.6.

5.7.

O

Click Add Horizontal Caliper

BEE

Measurements.

Pointer changes to

Point at beginning of measurement.

Orie Strip i lfzsmms = lfrommemy | [none

Patiert: Braven, Bobly Date: 11192002 Time: 2:57:34 PM Duration: 00:00:18

<[ =] 1 WEL\J z|T|< & El

Sampling Rate: 230sps

Click and drag pointer to end of
measurement.

Caliper appears.
Caliper length and label change with
changing position.

Release mouse button.

ransmitter ID 75003804C5
vent # 2 - Tue Mov 19 14:57:34 2002
reEvent 5 5 PostEvert 10 = Flags 1

Measurement units/label menu appears.

Choose units or label.

ECG Viewer remains in caliper mode until
another mode selected.

Note: Vertical Caliper Measurements tool
works similarly.

These caliper measurements will print on

the ECG samples on the report if within the
Red highlighted area.

QT
® Molabal

CHT «
>
00:00:09.18;

0on0:0000 4k

-| RR 78.9 bpm, PR 0.196 Sec, QRS 0.172 Sec, QT 0.43

¥ Sec, QTc 0.496 Sec

R

Click Beat Caliper tool.

Pointer changes to || | | |

Move mouse close to a QRS complex and
click once. A vertical line caliper appears
and displays the measurements on screen.
ECG Viewer remains in Beat Caliper mode
until another mode selected.

These calipers do not print on reports.

B cNEE B Boniee) M a onneens |

6. Add text comments.

6.1. Click Add Text Comments. =2 _ — ﬂ:g@i
» Pointer changes to I s <l <l <Jfommmy <Jfoe  <Jlore <JBE 1| [% @il z’T)e< 8] B
Patiert: Braven, Bobly Date: 11192002 Time: 2:57:34 PM Durstion: 00:00:19 Sampling Rate: 250sps
6.2. Position pointer where you wish to place
text comment and click. I
» Text box appears. 'fgnnf";'gmﬁg EE.D\«S? S:iﬁﬁ? 34 2002 Aar\‘::tlmp
Prefvent 5 = PostEvent 10 = Flags 1
37 e A A ﬂF"\ P e | B i =
6.3. Enter comments.
6.4. Click anywhere outside of text box.
» Textbox closes.
» Comment text remains superimposed on
ECG trace.
U Text comments print on reports if within . .
red hlghllghted area. 00000000 4 b 00000818,
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7. Enter findings.

7.1. Click E button on the toolbar to open the
editing screen.

4 Arrhythmla ECG dlalog appears with e Strip S fesmmes Jfiommmy <|fore <Jfwne <[B T] & QU] E[ T8 E|
Recelvmg tab selected. Patiert; Braven, Bobly Date: 1171912002 Time: 2:57:34 PM Duration: 00:00:19 Sampling Rete: 250sps
U Receiving and Editing information should 3
be entered into each ECG Event editing
screen to print on the report. Editing
information will be printed for each sample ’
marked in each individual event. ‘
ranzmitter ID 75003504C6 anLial
vert # 2 - Tue hlow 19 14:57.34 2002 {ctivation|
Pre€vent 5 5 PostEvert 10 = Flags 1
0 : N : NI . S 1 S T B RS (7 SIS P I B
B (0) Arrhythmia ECG - Braven, Bobby - Not Edited El
1. Receiving I 2 Editing I 3 Options 1
Date/Time: [Fdb-01-2000 093023 ReceiingTech: (R =+
Diescription: ‘7outine Transmissian j
Symptoris: Plzzmess j e
. oy < Activity: Walking j >
7.2. Click Edltlﬂg. I - ﬁ 0:00:08.18
ocation: j
Paient T3 Cancel o | Hen |

7.3. Enter name or initials of Editing Tech.

U The status of the ECG is considered to be
“Not Edited” (as indicated in title bar of
this dialog) until both the Receiving Tech
initials on the Receiving tab and the
Editing Tech initials on the Editing tab
have been filled in.

U Ifyou do not care about the status of the
ECG, you need not enter Editing Tech
initials. Status is displayed in ECG list.

B (0) Arrhythmia ECG - Braven, Bobby - Edited/Not Sent
1. Recewving 2 Editing ] 3 Dptions ]

Techrician's j Editing Tech. ,ﬁ
. . Findings
7.4. Select appropriate findings from —— Rate: 53 to ito
Technician’s Findings list and click Normal Sinus Fhgthin ST o 18
Append, or enter findings as free text in oRs: [092 o [o55
the text box below. ot / [ o [369
N . o |

7.5. Enter or modify appropriate measurements.

Patiert... OK | Cancel | Apply | Help |

7.6. Click OK.
» Arrhythmia ECG dialog closes.

7.7. Click Options

&= (0) Arrhythmia ECG - Braven, Bobby - Edited/Not Sent

» Click Use Local Settings to use the viewer T el
settings for printing. This includes speed, = Local_semngs
gain, filter, grid on/off, invert. = = O
» Reporting View allows the modification = = i
of the marked strip that will be printed. If a -
3 channel event is recorded and only the
2 ch strip is to be printed choose One Strip iz TN - | M =i i
from the drop down menu to override - | Fonpeed
printing the strip in 3 channel mode. Pt | o6 | coen = e
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Generate report

8. Create and print report

8.1. With the ECG viewer window still open
select Create from the Report menu.

U Ifyou have just reviewed the ECG as
described above, it is already selected.

U All ECG samples marked in all events
within the same ECG transmission will
print on the report.

» The Patient Transmission Report is
generated and displayed in the print
preview window.

8.2. To inspect the report, use the Fitted
button to select magnification, and the
scrollbars to see various parts of the
report page(s).

8.3. Click Print to print to the default printer.

O The Fax, Email and Send buttons are
disabled in GEMS Lite but such features
are available in the full version of GEMS
Arrhythmia. On the main screen under
the Tools menu choose Upgrade to Full
Version to automatically send an email to
a sales representative.

SI-W Feport

Tools  Help

one Create ] |||_

Arrhythmia ECG - Braven, Bobby - Not Edited _];EE

One Strip = = mme ][0 mminy <|[none < ][sotiz j[ﬁﬂ [ a WJH I|To<| W E_J

Patient: Braven, Bobly Date: 111 8/2002 Time: 2:57:34 Ph Duration: 00:00:13 Sampling Rate: 250sps

ransmitter 1D 750035046
wert # 2 - Tue Mov 19 14:57:34 2002
PreEvert 5 = PostEvert 105 Flags1 |
R | e g

fanuel
\aicthvetion|

1 U A i i W | .:.n:

CHT v

00:00:0000 4 | 00:00:09.16

Help

b 2 4 ] 3 S = 5 &

Eax E Mall Trink S Sond Fitted Portrat  Landscape Eack /msc

8.4. Click Close.
» Print Preview dialog closes.
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Transtelephonic Pacemaker ECG Monitoring

This chapter describes some of the main tasks associated
with Transtelephonic pacemaker ECG monitoring in
GEMS Lite. They are:

e Step 1 — Add a New Patient

* Step 2 — Associate a Physician

* Step 3 - Receive ECG transmission
e Step 4 -5 - Review and Edit ECG
* Step 6 - Print a Report
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Add New Patient
1. Create new patient record.

1 New Patient E‘
1 Demogaphics | 2 Moritoring Informstion | 3 assaiations |
1.1. From the New menu choose Patient. Patent 0 }‘ sl }’“““ =
ast Name: irst Name:
» New Patient dialog opens at Mades | e
. Suffix [ Bith Date: |
Demographics tab. o | o | N
Other 1D [ A4UID: [
Strest: [
[
City [ x| state [ |
2P Code: | County: | -]
Description: Phone Number: Extension:
B [ = I
1.2. Fill in demographics information. [ = I
. . . Far [
O  Fields labeled in boldface must be filled in B =
. . T New Patient £y
(Patient ID, Last Name, First Name). Heght || T e
M Sel f Select Append b dd
- elect o type information. Select &ppend bulton to a
. . / BleLiplikiz T < dmpend
1.3. Click Monitoring Info tab. Do S s
ymnptoms: Palpitations ar st Pain
O This is a free text field that prints on the o el

TTM Pacing report. This field should be
used for information such as Device
implanted, Mode etc.

[ Close On OK [ Cancel Help
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40 [ Transtelephonic Pacemaker ECG Monitoring

2. Associate patient and physician

2.1. Click Add on the Associations tab.

f| New Patient

» Save Patient dialog opens if the patient 1 Demapics, 2 Montarig famaion L 3 Az
hasn’t been previously saved. Nare  [Toe [ Associaion
Save Patient
@ Add Patient record to the database?
22. Click OK. e
» Save Patient dialog closes.
» Select Physician dialog opens.
2.3. Find and select physician.
. . . i, Association Physician
2.3.1. Click Fill List. e =
s
» List fills with physician names. <l Physicians | gl |
2 3 2 Cl k h .. N Physician M... |Address. | Specialty | Group | Phone |
3.2. ick on p yslc1an S name. Good, Or. Fred 111 Main.. Cardiologist Al == FER)
Association: [sners Practitionsr =lr %z;:‘nvses
. . /
2.4. Select Association type. e e e
U The default association is Follow-up. The
physician with the association type follow-
up will print on the report. Additional
physicians can be added but only the
Follow-up physician will print on the 3 (1) i Pasen S =i
repOI"l‘. 1 Demographics | 2 Monitoring Information 3. Associations
U A New Physician can be entered here as
well by clicking the New button.
2.5. Click OK. )
» Association Physician dialog closes. /
» New association appears on Associations
tab.
Add Delete | Ehangel
¥ Close On 0K Ok | Cancel | e |

GEMS Lite Manual Revision Date: 29-Nov-04
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Receive ECG
3. Receive patient call and Record ECG transmission

File Edit m Tools  Help
e o o | PatientM  Patient

. . . Appleby, t Arrhythmiaf12 lead ECG [Frors
3.1. Select Patient name from the patlent list. Tieby, Sarsh A TTM Pacing ECG *each Suest, Oakland, Calfomia, 435 343 5324
Braven, Bobby 53 acing it Stiest, Philadelphia, Penrsylvania, .. 534 5234
Halywell, Holly BGAGIE  Femals  Avhyhmia  Active 234 ishmond Foad, Washington, Distist 0 345 6345
Millken, Tracy GG/ Femals  Pacemsker  Active 2343 Reven'wap, Las Vegas Nevads 234 343523
Paiker, Famly 22 JEAWE Mals Atythmia Active  Tatoms ‘washington, 32432, Uitsd States 345 6345
THAGE JEAF5  Femels  12lesd  Active 6435 Randy Shest dackson Mississppl 53 453 3243
hogsper Temy 2323423 YA Mk Atythmia Active 5345 Waler Strsst, Salem Massschusets, | 3435323
Noealers il 232 247135 Mals Pacemsker  Adtive 3423 Fancy Shieet Kanoss Oty Kansss 43 42 6453
wisstherby. wims 52423 5G9 Femels  120ssd  Active 3245 SmellinsWay Baltinors Mapland | 532 3464
“Yander, Herry 365 B34 Mk 120ead Botive 345 Tellow Strest Washington, Disvict of €. 234 5345
. .
3.2. Click TTM Pacing ECG from the

New Menu.

TTM Pacing ECGs %Auhylhm\aﬂ 2Lead ECGs

Type | Transmit Date | Patient Mame Recorded Date: Status | EditInitials | Fecsived| &
Event-1 Chanvel - [Manud]  12/9/2002 037934 PM  Draven, Bobby  11/19/2002 0257.45PM ot Edited

Event-1Chanvel- [Manua]  12//2002031%:34PM  Draven, Bobby  11/19/20020253.33PM Mot Edited

Main - 1 Channel - [Manual] 12/9/20020324:14PM  Braven, Bobby  12/9/20020324T4PM Mot Edited Joshua
Event-3Chanvel - [Manud]  12//200203:2814PM  DBraven, Bobby  9/25/20020257.01PM Mot Edited

Event-3Chanvel - [Manua]  12/9/200203:2614PM  Draven, Bobby  9/25/2002024352PM Mot Edited L
Main - 12 Lead 12/3/200203:26:21 M Braven.Bobby  12/9/2002032621PM Mot Edited Joshua
< | >

» ECG Viewer opens in new window.

O Strip L]m’QSmmfs ~|[1omminy =|[none  |[40Hz j[@ﬂ W n mml:l

3.3. Cth Stal‘t Recording. atient: Sppleby, Sarah Dafe 127117200 Time: 10 P Durstion, 0000 Sampling Rate: 100sps
RECORDING

O To ensure all FSKs are recorded, be sure
to click Start Recording before the patient
starts sending the ECG from their device.

v

Recording indicator appears. i i oo T R (R T
O A4 TTM Pacing ECG is a continuous ﬁ,fV JL JV JL JV Jy JV JM JLJL
recording of all 3 segments (Presenting, ' 5 ) T T M B
Magnet and Final) and should only be
paused in between segments not stopped
completely.

Recording EE

Manual Revision Date: 29-Nov-04 GEMS Lite
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3.4. Ask patient to begin sending ECG.
» ECG is displayed as it comes in.

3.5. When the patient’s ECG recording has

Fon GEMS Lite - C:\Program Files\GEMS\GEMS Lite.mdh

B New Arrhythmia ECG -

Appleby, Sarah

finished playing back, click Stop
Recording.

» Recording indicator disappears.
» New ECG record is displayed in window.
» ECG Viewer displays ECG Editing

File _Report Tools  Help
One Strip < [ mmws < |[lommmy <one ~|fsorz | 1| lb_il olp | oo
atiert, Applely, Sarah Date: 12011/2002 Time: 3:22:10 P Duretion: 00:00:00 / Sampling Rate: 100sps
i I i I I i I
Il I I I I I I
i
&

m . New Arrhythmia ECG - Braven, Bobby

controls.

» Terminate patient call.

File Report Tooks Help o
One Strip < =lfzs mmes j|1nmmm«vj|mne ﬂlmHz ﬂ]@ﬂ ,—) k @lm] l| T T|2< B Ll
atient; Braven, Bobly Dite: 12/10/2002 Time: 11:39:43 AM puratiu’\: 00:01:04 Sampling Rate: 250sps
,' ~|
|
|
|
Ml } J
Joctivation|
; | \ i g
[ I { i I
e I I ) PN N 097, B 7 Y | e e . e S g [
CHI v
E4] i 2]
00001050 4 [b OCOB19ES

GEMS Lite
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Review and Edit ECG

4. Sample ECG.

4.1. Click Sample.

» Pointer changes to g:-c:
4.2. Point at the beginning of desired portion of
ECG trace and click on it.

» A 8-second sample, beginning where you
clicked, is created. The sampled part of the
trace changes colour.

» Sample options menu appears.

4.3. Choose a sample option:
4.3.1. Mark the area of the ECG that is the

R (28) T ECG - Milliken, Tracy

Fle Report Tools Help

|sinle Lead A =[zsmme <l [iommmy ~|[vone ~|[40mz j@ﬂ ’TQ [l el | E | T [ <] 1 E

Patiert: Milken, Tracy Date: 121172002 (= Time: 11:46:58 AM Duration: 00:00:45 Sampling Rate: 100sps

Fresenting

e ek

Magnet

|
8sec
16 sec

24 sec
32 sec

Presenting portion of the ECG. ———  e— o= | e
4.3.2. Mark the area of the ECG that is the i sl
Magnet portion of the ECG. epicns
4.3.3. Mark the area of the ECG that is the = oo
Final portion of the ECG.
» Size or label applied accordingly.
Manual Revision Date: 29-Nov-04 GEMS Lite
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5. Take measurements.

5.1. Click Add Horizontal Caliper o R R e e T
Measurements. File Report Took Help
sngelead |1 <|[25mme |[iommmy <[fuone <o B 1] [k @) I|T|*<[& E|
Patiert. Millen, Trecy Date; 12/11/2002 [Time; 11,46:58 AN Duretion: 000045 Sampling Rale: 100sps

iGains

Fresenting

» Pointer changes to

5.2. Point at beginning of measurement. JﬂM@M@M | QV/

5.3. Click and drag pointer to end of
measurement. \

Caliper appears.

Caliper length and label change with
changing position.

5.4. Release mouse button. F'ﬁ\/q—ﬁ\/fL i\ _“_?Q bpm ’J\J,J W

Rate

» Measurement units/label menu appears. "
5.5. Choose units or label. . ol Ly

00000818 4 » 00:00: 27 56/

» ECG Viewer remains in caliper mode until
another mode selected.

U Note: Vertical Caliper Measurements tool TRR78.9 bpm, PRU.196 Sec, QRS 0.172 Sec, QT 0.432 Sec, Qlc 0.496 Sec
works similarly. R

5.6. Click Beat Caliper tool.

» Pointer changes to || |||

5.7. Move mouse close to a QRS complex and M r\' ‘/\J
click once. A vertical line caliper appears I AN
and displays the measurements on screen.

» ECG Viewer remains in Beat Caliper mode
until another mode selected.

GEMS Lite Manual Revision Date: 29-Nov-04
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Generate report
6. Create and print report

6.1.

6.2.

6.4.

With the ECG viewer window still open
select Create from the Report menu.
If you have just reviewed the ECG as
described above, it is already selected.

The TTM Pacing Report is generated
and displayed in the print preview
window.

To inspect the report, use the Fitted

Tools  Help

reake ] |||_

Patiert: Millken, Tracy:

Date: 12¢111/2002 ITime:; 11:46:58 AM Duration; 00.00.45

Gains

B (28) TTh ECG - Milliken, Tracy =13

File Report Tools Help

[sngeteas ][l <|[25mms < |[ommmy < [woe  ~|fione | I| % QU T| T <[ B El

Sampling Rete: 100sps

Presenting

N SeUSed SRS RS AP AEEy e AR R EEY o

Magnet

button to select magnification, and the
scrollbars to see various parts of the

report page(s).

Click Print to print to the default printer.

The Fax, Email and Send buttons are
disabled in GEMS Lite but such features
are available in the full version of GEMS
Arrhythmia. On the main screen under
the Tools menu choose Upgrade to Full
Version to automatically send an email to
a sales representative.

I v
< >
00:00:09.18 4 00:00:27 56
h i ) 8 4 “ 1] L] a
el [ Pret Sren Sl Feted Porfgat (ardcioe Back [0
BSERSIIERR VI PASY UM K SN T VR O
: - 5
B = 2y £ =] iy oo = 5 &
Help Eax E Mal Drink Save Send Fitted Portrak

Landscape Back /050

Click Close.
Print Preview dialog closes.

Manual Revision Date: 29-Nov-04
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46 12 Lead ECG Monitoring

12 Lead ECG Monitoring

This chapter describes some of the main tasks associated
with 12 Lead ECG monitoring in GEMS Lite. They are:

Step 1 — Add a New Patient

Step 2 — Associate a Physician
Step 3 - Receive ECG transmission
Step 4 — 5 - Review and Edit ECG
Step 6 - Print a Report

GEMS Lite
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Add New Patient
1. Create new patient record.

1, New Patient ﬁ‘

1 Demogaphics | 2 Moritoring Informstion | 3 assaiations |

Fax:

O  Fields labelled in boldface must be filled in B
(Patient ID, Last Name, First Name). ot nwEn "

Ethnicity x| Group [ |
Closing Date: Age

1.1. From the New menu choose Patient. poten 1 }‘ o }’“““ e
ast Name: irst Name:
» New Patient dialog opens at Mades | e
. Suffix [ Bith Date: |
Demographics tab. S 1 =
Other 1D [ A4UID: [
Strest: [
[
City [ x| state [ |
ZIP Code: | Country: [ -]
Description: Phone Number: Extension:
Phone: [ = [
1.2. Fill in demographics information. [ = |
[
\
[
[

v Close On 0K LCancel Help

GEMS Lite Manual Rev. 1.0 / 29-Nov-2004



48 [J12 Lead ECG Monitoring

2. Associate patient and physician

2.1.

» Save Patient dialog opens if the patient

Click Add on the Associations tab.

1| New Patient

hasn’t been pI‘CViOuSly saved. 1. Demosraghics | X Monitoring Information 3. Associations
Name | Twpe\ | Association
Save Patient E
@ Add Patient record to the database?
2.2. Click OK. = e
» Save Patient dialog closes.
» Select Physician dialog opens.
2.3. Find and select physician.
2.3.1. Click Fill List.
. . .. Select Physician: \
» List fills with physician names. |<upmy—>;[ Bl | o
2.3.2. Click on physician’s name Physician M. [ Addiess | Specialy | Gioup | Phone | —
bt p y M ood, Di. Fred 111 Main. Cardiologist Al
Cancel Help
/ Association: [Gencr Fractiioner = gzgsfs
2.4. Select Association type.
o . . Close On 0K Mew.. gk L. | Hel
O  Please note Physician does not print on the Bt | e e Fa
12 Lead Report.
2.5. Click OK.
» Association Physician dialog closes. i (1) Edit Patlentolll : x|
.. .. 1. Demographics | 2. Monitoring Information. 3. Associations
» New association appears on Associations
tab' Association |
Add | Deletel Ehaﬂgel
v Cloge On OK oK | Cancel | Help |
GEMS Lite Manual Revision Date: 29-Nov-04
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Receive ECG
3. Receive patient call and Record ECG transmission

w0 File  Edit m Tooks  Help

Patient 1|~ Patient
i i i L~ prrhythmiall2 Llead B ——— | Phee ||
3.1. Select Patient name from the patient list. A s Aiileb( ythmiaf

4 Street, Dakland, Califarnia, 435 3435324

. eel. Philadelphia, Persylvania, 5345234

Hallwel, Holy 3454 TTM Pacing ECG wnd Raad, Washingtan, District .. 345 6345
Millken, Tracy
Paker, Farily

2 4/6/1964  Female Pacemaker  Active 2343 Raven'Way, Las Vegas. Mevada, 234 3436234
5623432 3/5/1966  Male Artwthmia Active Tacoma, washington, 32432, United States 3456345
75466 3/5/1956  Female 12-Lead Aotive B435 Randy Gtreet, Jackson, Mississippi, 53 45633243
2323423 4/4/1334  Male Atythmia Active 5345 Walker Street, Salem, Massachusetts,.., 3435323
236235 2/4/1966  Male Pacemaker  Active 3423 Fancy Street, Kansas City, Kansas, 43 342 B463

Weatl’\er’by, Wima 52423 5/6/1934  Female 12-Lead Active 3245 Small Vine Way, Balimore, Marpland, ... 532 3454
‘rander, Heny 36345 E/3/1964  Male 12-lead Active 345 Yellow Shieet, 'Washington, District of C. 234 5345
. .
3.2. Click Arrhythmia/12 Lead ECG

from the New Menu.

TTM Pacing ECGs @Anhythm\aﬂ? Lead ECGs

Type | Transmi Date | Patiert Name | Fiecaided Date: | Status | EditInitials | Reosived | &
Event - 1 Channel - [Manual] 12/9/2002 03:19:34 PM  Braven, Bobby 11/18/2002 025745 P Mot Edited
Ewent - 1 Channel - [Manual] 12/9/2002 03:19:34 PM  Braven, Bobby 11/19/2002 025333 PM Mat Edired
Main - 1 Channel - [Manual] 12/9/2002 03:24:14 PM Braven, Bobby 12/9/2002 03:24:14 PM Mot Edited Joshua
Evwent - 3 Channel - [Manual] 12/8/2002 032414 PM  Braven. Bobby 8/25/2002 02.57.0 PM Mot Edited
Event - 3 Channel - [Manual] 12/9/2002 03:24:14 PM  Braven, Bobby 9/25/2002 02:43:52 PM Mot Edited s
Main - 12 Lead 12/8/2002 0326:21PM  Braven, Bobby 12/3/2002 03:26:21 PM Mot Edited doshua
< >
» ECG Viewer opens in new window.
| New Arrhythmia ECG - Milliken, Tracy, 9 (=1E3]

Fle Report Tools Help

12 Lead O | T | | o | = E};}TM

Patient: Miliken, Tracy Diate: 12/11/2002 Time: 9:45 25 P Duration: 000 Sampling

EEEFRRESAY:

Vi w4

U  Ifthe ECG waveform does not look correct ﬂﬂj‘/\_ﬂﬂ/\_ RN AN YN ‘\;‘\,, _\,1|(7

select the Configure Device button to T v 7 - Vs
change the driver for the 12-lead device
from the Demodulator drop down list. ﬂ

e[ |

pte: 100sps

3.3. Click Start Recording.
O To ensure all FSKs are recorded, be sure ﬂ

to click Start Recording before the patient _,\A;\_ —\[\r—Yv—
aVR

starts sending the ECG from their device. i

RECORDING| ©

IS

requency Demodulator

L i3 a FRelative Powsr Drag the tiangle tafset the threshold.
» Recording indicator appears. f
ﬂ | | | fomoo
L
Recording
L

OHz 4000 Hz

Demodulator: IKing OF Hearts - ™ Invert Signal

I puA{Bera ERa0— -]
Braemar i Lancel Apply
Pacetrak ] _I _I
Pacelrak P‘LIS LI — —— — — — ——
Heart Aide EZD
Hea Aide EzzEz-P\j
I King of Hearts 3000E ¥
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50 012 Lead ECG Monitoring

3.4. Ask patient to begin sending ECG.
» ECG is displayed as it comes in. W8 New Archythmia ECG - Milliken, Tracy Ex

File Report Tools Help

12 Lea A =lfzsmms <] [rommmy +(hone < Jfsonz + ’@ﬂ ’Tﬂ’? * l:|

C .

3'5' When the patlent S ECG recordlng has Patiert. Milliken, Tracy Date: 12¢111/2002 Time:; 9:45.23 P Duration; 000012 Sampling Rate: 100sps
finished playing back, click Stop RECORDING] ~
Recording.

RERRECRARRREENI

| RALE) ERE

EENASEEENAREEY RS

] avil

S
-
ELr

o
[

o avF v3

I
il
il
I

sedais
St it
P

Recording

B (30) Arrhythmia ECG - Milliken, Tracy - Not Edited

File Report Tools Help
12 Lead = wlfzsmme = [[rommmy v {[wone ][40 Hz jl@ﬂ k\Q|MmL.I|I|T%<|N\ E|
Paticrit: Miliken, Tracy Date: 124172002 Time: 11:30:08 A Duration: 00:00:07 Sampling Rate: 100sps
1 A
» Recording indicator disappears. ) b v “ I
. . 3 3 I VR VT ']
» New ECG record is displayed in window. Tror 2 l
» ECG Viewer displays ECG Editing AH_ _W"V JL o= e ﬂ L ﬂ
controls.
| [ I avi V2 V5
| | n avF V3 L'{i]
Sample ECG Commert
[ g aREEE R R R oS R e A S
g
DOOTO00D 4 b DOOD07ER
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Review and Edit ECG

4. Sample ECG.

4.1. Click Sample.

Fie Report P
» Pointer ChangeS to g?C: 12 Lead =i =l[esmme <|[1ommmy <|[one ~|[sare <||HH I |Gl | E[ T 2<| B E
Fatisrt: Milken, Tracy Diste: 120143003 Times: 11-50r06 AM Puuration: fienry a7 Sampling Feate: 100sps

4.2. Point at the beginning of desired portion of
ECG trace and click on it.

» A 8-second sample, beginning where you

NS N B

! avR Vi '

» Sample options menu appears. [ VL v2 Vs

4.3. Choose a sample option:

n aliF Vi V6

Sample ECG Commert

AR AT RIS - i ST

4.3.1. To make the sample longer,
click 8sec, 16sec, 24sec, etc.

clicked, is created. The sampled part of the L ED
trace changes colour. ﬂ _VM NI M ﬂ

4.3.2. To place a label on the sample,

& sec

click one of the selections or to 16 oo
. 0~
have no label, click No label. e s
4.3.3. Size or label applied accordingly. 40 5ec
» Size or label applied accordingly. e Ryt

Ventricular Arrhythmia
Sinus Tachycardia
Sinus Bradycardia
Atrial Fibrilation
Pause
5T Change

® Malabel
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5. Take measurements.
5.1. Click Add Horizontal Caliper

Measurements. Fle Report Tools Help
12 Lead < =5 mms < fommmy <[fuone ~[fion: ][ 1| QU I T =<8 E|
Patiert: Milliken, Tracy Date: 1201172002 Time: 11:50.08 Ap Dwration: 00.00.07 Sampling Rate: 100sps
» Pointer changes to ll. ﬂ q ?| | I
5.2. Point at beginning of measurement. u d
i avR VT V4
5.3. Click and drag pointer to end of i e ‘
measurement. SR SEEN W AN ﬂ
» Caliper appears. " i w vs
Caliper length and label change with ﬂ
changing position. A A L R s A
80 bpm Units b J\_JH,J Ve
5.4. Release mouse button. s ANl V_/Q -
» Measurement units/label menu appears. ﬂ "
. - T
5.5. Choose units or label. . o lzbe N
» ECG Viewer remains in caliper mode until i
another mode selected.
U Note: Vertical Caliper Measurements tool TRR78.9 bpm, PR0.196 Sec, QRS 0.172 Sec, QT 0.432 Sec, QTc 0.496 Sec
works similarly. R

5.6. Click Beat Caliper tool.

» Pointer changes to || |||

5.7. Move mouse close to a QRS complex and M r\' ‘/\J
click once. A vertical line caliper appears AL

and displays the measurements on screen.

» ECG Viewer remains in Beat Caliper mode
until another mode selected.
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Generate report

6. Create and print report

6.1. With the ECG viewer window still open

select Create from the Report menu.

File Report Tools Hslp

Create

B (30) Arrhythmia ECG - Milliken, Tracy - Mot Edited

If you have just reviewed the ECG as
described above, it is already selected.

12 Lead
Patiert: Miliken, Tracy

Date: 12111/2002

S s oms < [rommmy <[[wone ~fsone <[ 1|

Tools

Time: 11:50:08 AM

Help

b

Dwration: 000007

n | k| T[T <[ E

Sampliing Rete: 100sps

The 12 Lead Report is generated and
displayed in the print preview window.

Bas EEER faB

avR

A FUREY i

v1

HER \Eeaniax

'S

Sampls ECG

avl

RS ERER ERERFARRRFARREEN (REAN (AR

v2

YT

V5

"

e

avF

HENPERESaE

e

v

V6

Sampls ECG

M

&

Reate 60 bpm

Commert

&

i

00000000 4 ¢ 00:00.07 B9

6.2. To inspect the report, use the Fitted

button to select magnification, and the
scrollbars to see various parts of the
report page(s).

Click Print to print to the default printer.

The Fax, Email and Send buttons are
disabled in GEMS Lite but such features
are available in the full version of GEMS
Arrhythmia. On the main screen under
the Tools menu choose Upgrade to Full
Version to automatically send an email to
a sales representative.

--------------

s

Help

b

Fitted Portrak  Lan

=] 3 @

dscape Back /050

6.4. Click Close.
» Print Preview dialog closes.
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Using the ECG tools

This chapter shows how to use the tools that are part of
the ECG Viewer. ECG Viewer tools are divided into three
categories:

Display tools — control the appearance of the ECG
display. Controls for the display functions are always
present on the ECG Viewer.

Recording tools — for recording incoming (real time)
ECGs. Controls for the recording functions are
present only when you are receiving an incoming
ECG.

Editing tools — for measuring, marking, and
annotating an ECG in the database. Controls for the
editing functions are present only when you are
viewing an already-recorded ECG.

Each category of ECG Viewer tool is described in detail
in the following pages.

GEMS Lite
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Display tools

1. Overview of display tools on the ECG Viewer toolbar.

O  See numbered items following for details
on these tools.

1.1. Gain

» Determines the voltage scale of the ECG
display. Measured in mm/mV, the nominal
vertical distance on screen and hardcopy
that corresponds to one millivolt of signal
strength on the ECG trace.

1.2. Speed

» Determines the time scale of the ECG
display. Measured in mm/s, the nominal
horizontal distance on screen and hardcopy
that corresponds to one second of time on
the ECG trace.

1.3. Rhythm Lead
» 1In 12-lead view, determines which channel
is displayed as rhythm lead at bottom of
view. Irrelevant in other views.

I- [E[x]

1.4. Strip View
» Determines the overall type of view of the
ECG signal.
1.5. High-Pass Filter

|one: Strip
Patient: Braven, Bobby

e\ e e

Date: 12M0/2002

;

Time: 11:39

=l . J’%ﬁ T

x| QAN k| | T/2<| 8 E

Sampling Rate: 250sps

» Determines the cutoff frequency of high-
pass filtering applied to the ECG signal.

1.6. Low-Pass / Notch Filter

tanual
prctivation
. I |

» Determines the cutoff or centre frequency
of low-pass or notch filtering applied to the
ECG signal.

1.7. Show / Hide Grid
» Causes a grid indicating regular horizontal
(time) and vertical (voltage) increments to

be shown or hidden on the ECG display.

CHT ~
2
00001050 4 [» O0:00:19.88

1.8. Invert Trace
» Causes the ECG signal voltage to be
displayed inverted, in case ECG monitor
leads were reversed during recording.

GEMS Lite
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2. ECG Viewer display tools — Gain selector.

2.1.

2.2.
2.3.

24.
2.5.

1 mm/s [singie Lead = =lfzsmms =][1omminy [fnone = ][nane j[@ﬂ

A very “tight” voltage scale. The ECG
trace is displayed over a relatively small
vertical distance. Corresponds to zooming
out on the voltage scale. Details of the
signal may be difficult to resolve.

10 mm/s

The default. Shows the ECG trace spread
out enough vertically so that obvious
features of the signal are easily resolved.

200 mm/s

A very “stretched” voltage scale. The ECG
trace is displayed over a relatively large
vertical distance. Corresponds to zooming
in on the voltage scale.

3. ECG Viewer display tools — Speed selector.

3.1.

3.2.
3.3.

34.
3.5.

2 5 mm/s ISingIe Lead j Il et |25 s j|1n mmim’y jlnﬂna jlnnne jlﬁl‘

A very “tight” time scale. A large amount
of ECG trace is displayed in a relatively
small horizontal distance. Corresponds to
zooming out on the time scale. Details of
the signal may be difficult to resolve.

25 mm/s

The default. Shows a modest amount of
ECQG trace in a typical display width, with
enough detail that obvious features of the
signal are easily resolved.

500 mm/s

A very “stretched” time scale. A small
amount of ECG trace is displayed in a
relatively large horizontal distance.
Corresponds to zooming in on the time
scale.
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4. ECG Viewer display tools — Rhythm Lead selector.

4.1. 1

» Lead I (self-explanatory).
4.2. I

» Lead II (self-explanatory).
43. 1II

» Lead lII (self-explanatory).
44. ...
4.5. V6

» Lead V6 (self-explanatory).
4.6. CH1

» Channel 1 (same as Lead I)
4.7. CH2

» Channel 2 (same as Lead II)
4.8. CH3

» Channel 3 (same as Lead III)

ISlngIe Lead j Il s IZS mmes j|1u mmim’y jlnone jlnone j[@l‘
=

5. ECG Viewer display tools — Strip View selector.

5.1. Single Lead

» Displays one lead (channel) of an ECG.
The trace is wrapped across as many strips
as will fit vertically in the screen area
available for the ECG display (usually
three). For a 12-lead ECG, the one lead
displayed is selected by Rhythm Lead
control.

5.2. One Strip

» Displays one lead (channel) in an ECG in a
single strip centred vertically in the ECG
display area. For a 12-lead ECG, the one
lead displayed is selected by the Rhythm
Lead control.

5.3. 2 Channels
» Displays a 2-channel ECG. Each channel
shown in a single strip, and the strips are
stacked vertically above one another. The
display is blank for any other type of ECG.
5.4. 3 Channels
» Displays a three-channel ECG. Each
channel shown in a single strip, and the
strips are stacked vertically above one
another. The display is blank for any other
type of ECG.

2 Channels

3 Channels

Stacked

12 Lead

12 Lead - No Rhythm
12 Lead - Lateral

12 Lead - Inferior

12 Lead - Antetior
12 Lead - Septal
12 Lead - Posterior
12 Lead - Limb 1
12 Lead - Limb 2
12 Lead - Chest 1

12 Lead - Chest 2

5.5.

5.6.

ijZSmmfs jlwmmlmvjlnone jlnone j[@l‘

Stacked

Displays all leads (channels) in an ECG.
Each lead is shown in a single strip, and
the strips are stacked vertically above one
another in the following order from top to
bottom:

11 4 avL 7 V1 10 V4
2 1II 5 aVR & V2 11 V5
3 I 6 aVF 9 V3 12 V6

A single-lead ECG is displayed in the Lead
II (strip 2) position.

12-Lead

Displays all leads (channels) in a 12-lead
ECG. Each lead is shown in a single strip,
and the strips are shown in a 3x4 + 1
format laid out in the following pattern:

| aVL V1 V4
11 aVR V2 V5
11 aVF V3 V6
Rhythm Lead

A single lead, selected by the Rhythm Lead
control, is repeated in the Rhythm Lead
strip at the bottom.

A single-lead ECG is displayed in the Lead
IT and Rhythm Lead positions.
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5.7. 12-Lead - No Rhythm 5.12. 12-Lead - Posterior
» Displays all leads (channels) in a 12-lead » Displays 4 selected leads (channels) of a
ECG. Each lead is shown in a single strip, 12-lead ECG. Each lead is shown in a
and the strips are shown in a 3x4 format single strip, and the strips are stacked
laid out in the following pattern: vertically, in the following pattern:
I aVL Vi V4 -V1
11 aVR V2 V5 -V2
111 aVF V3 V6 -V3
» A single-lead ECG is displayed in the Lead V4
II position. » The “—” before each lead name indicates
5.8. 12-Lead - Lateral the lead signal is inverted in this view.
» Displays 5 selected leads (channels) of a » A single-lead ECG is not displayed.
12-lead ECG. Each lead is shown in a 5.13. 12-Lead - Limb 1
single strip, and the strips are stacked » Displays 3 selected leads (channels) of a
vertically, in the following pattern: 12-lead ECG. Each lead is shown in a
I single strip, and the strips are stacked
avVL vertically, in the following pattern:
V4 I
VA 11
V6 Uil
» A single-lead ECG is not displayed. » A single-lead ECG is displayed in the Lead
5.9. 12-Lead - Inferior II position.
» Displays 3 selected leads (channels) of a 5.14. 12-Lead - Limb 2
12-lead ECG. Each lead is shown in a » Displays 3 selected leads (channels) of a
single strip, and the strips are stacked 12-lead ECG. Each lead is shown in a
vertically, in the following pattern: single strip, and the strips are stacked
I vertically, in the following pattern:
11T aVR
aVF aVL
» A single-lead ECG is displayed in the Lead aVF
II position. » A single-lead ECG is not displayed.
5.10. 12-Lead - Anterior 5.15. 12-Lead - Chest 1
» Displays 4 selected leads (channels) of a » Displays 3 selected leads (channels) of a
12-lead ECG. Each lead is shown in a 12-lead ECG. Each lead is shown in a
single strip, and the strips are stacked single strip, and the strips are stacked
vertically, in the following pattern: vertically, in the following pattern:
\2! \2!
V2 V2
V3 V3
V4 » A single-lead ECG is not displayed.
» A single-lead ECG is not displayed. 5.16. 12-Lead - Chest 2
5.11. 12-Lead - Septal » Displays 3 selected leads (channels) of a
» Displays 2 selected leads (channels) of a 12-lead ECG. Each lead is shown in a
12-lead ECG. Each lead is shown in a single strip, and the strips are stacked
single strip, and the strips are stacked vertically, in the following pattern:
vertically, in the following pattern: V4
Vi V5
V2 Vo6
» A single-lead ECG is not displayed. » A single-lead ECG is not displayed.
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6. ECG Viewer display tools — Hig

WARNING: Using a filter changes the
apparent amplitude and other features
of an ECG signal. If filters are used
inappropriately, they can create
misleading ECG traces.

6.1.

6.2.

6.3.

Filtering is used to remove unwanted
features from the ECG signal - noise,
signal drift, and other distortions. Filtering
changes how the signal looks as it is
displayed in the ECG Viewer, but does not
actually change the ECG stored in the
GEMS Lite database.

You can apply different filters, or none,
each time you view the ECG. You can
combine both high-pass and low-pass or
notch filtering on a single ECG.

none

(Default.) No low-pass or filtering is
applied to the ECG signal.

0.05 Hz

Suppresses variations in the signal that take
place over 20 seconds or longer

0.5 Hz

Suppresses variations in the signal that take
place over 2 seconds or longer.

WARNING: This setting may distort
import features of the genuine ECG
morphology.

h-Pass Filter selector.

ISlngIe Lead j Il s IZS mmes j|1u mmim’y jlnone jlnone j[@l‘
e

6.4.

A low-pass filter removes quickly varying
(high frequency) components of the
signal, which usually corrects problems
with noise (appearing as fuzziness), in the
signal.

The cutoff frequency determines what
frequencies are considered quickly
varying (high frequency) and hence how
much of the signal is removed. The higher
the cutoff frequency, the less of the
original signal is removed. It is best to use
the highest cutoff frequency that corrects
the problem on screen.

A notch filter removes a narrow band of
frequencies in the signal, which can be
used to correct problems with power-line
noise.

The notch center frequency selects which
band of frequencies to remove. The
frequency selected should be the same as
the AC power frequency in your area (60
Hz in North America; 50 Hz in most of
Europe).

1 Hz

Suppresses variations in the signal that
take place over 1 second or longer.

WARNING: This setting may distort
import features of the genuine ECG
morphology.

6.5.

2 Hz

Suppresses variations in the signal that
take place over 0.5 second or longer.

WARNING: This setting may distort
import features of the genuine ECG
morphology.
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7. ECG Viewer display tools — Low-Pass / Notch Filter selector.

WARNING: Using a filter changes the
apparent amplitude and other features
of an ECG signal. If filters are used
inappropriately, they can create
misleading ECG traces.

7.1.

7.2.

Filtering is used to remove unwanted
features from the ECG signal - noise,
signal drift, and other distortions. Filtering
changes how the signal looks as it is
displayed in the ECG Viewer, but does not
actually change the ECG stored in the
GEMS Lite database.

You can apply different filters, or none,
each time you view the ECG. You can
combine both high-pass and low-pass or
notch filtering on a single ECG.

none

(Default.) No low-pass filtering is applied
to the ECG signal.

15 Hz

Suppresses variations in the signal above
15 Hz.

WARNING: This setting may distort
import features of the genuine ECG
morphology.

7.3.

20 Hz

Suppresses variations in the signal above
20 Hz.

WARNING: This setting may distort
import features of the genuine ECG
morphology.

ISlngIe Lead

j I i IZS mmis jlwmmlmv jlnone jlnon

= 1]

U A high-pass filter removes slowly varying

7.4.

(low frequency) components of the signal,
which usually corrects problems with
signal drift (slow variation in the signal
baseline).

The cutoff frequency determines what
frequencies are considered slowly varying
(low frequency) and hence how much of
the signal is removed. The lower the cutoff
frequency, the less of the original signal is
removed. It is best to use the lowest cutoff’
frequency that corrects the problem on
screen.

30 Hz

Suppresses variations in the signal above
30 Hz.

WARNING: This setting may distort
import features of the genuine ECG
morphology.

7.5.

40 Hz

Suppresses variations in the signal above
40 Hz.

WARNING: This setting may distort
import features of the genuine ECG
morphology.

7.6.

7.7.

50 Hz — Notch

Suppresses components of the signal
between 49 and 51 Hz.

60 Hz — Notch

Suppresses components of the signal
between 59 and 61 Hz.

GEMS Lite
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8. Guide to information displays and miscellaneous controls on the ECG Viewer.

8.1. Sampling Rate
» Number of samples per second taken when

ECG was digitized.
8.2. ECG Duration
» Length of ECG in minutes and seconds.
8.3. ECG Recording Time
» Time of day ECG was recorded. \
8.4. ECG Recording Date ——— A
» Date ECG was recorded. e T, N \ \ '
One Strip = == mmIIS\VYHWUmmmVﬂ‘NUne\l”dU Hz jl@& QI k| Z\T[=<[ 8| E

.
8.5. Pat]ent Name stient: Braven, Bobby Date: 12/10/2002 Time: 11:39:43 AM Duration: 00:01:04 Sampling Rate: 250sps

» Name of patient whose record this ECG is
part of.

CHT v
>

)UU.WU.SU A4y 00001988

S

8.6. Display Begin Time
» Time (in seconds and hundredths from
beginning of trace) of first point of ECG
trace visible in ECG display area.

8.7. Scroll Back

» Click back arrow to move display back one
“page” in ECG trace.

> A “page” is the amount of trace that fits in
the current width of the ECG display area.

8.8. Scroll Forward

» Click forward arrow to move display back
one “page” in ECG trace.

» A “page” is the amount of trace that fits in

the current width of the ECG display area.

8.9. Display End Time

» Time (in seconds hundredths from
beginning of trace) of last point of ECG
trace visible in display ECG area.
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Recording tools
1. Overview of recording tools on the ECG Viewer toolbar.

U See numbered items following for details
on these tools.

1.1. Abort Recording

» Abandons storage of an incoming ECG
signal. No new ECG record is created in
the database.

1.2. Stop Recording

» Finishes storage of an incoming ECG
signal into the database. Creates a new
ECG record in the database.

1.3. Start Recording

» Begins storing an incoming ECG signal
into the database.

1.4. Pause Real-Time Display
» Puts display of incoming ECG signal “on
hold”. Incoming signal continues to arrive
and to be recorded if recording is on.

1.5. Resume Real-Time Display
» Resumes paused ECG signal display.

[singie tead <[ F[smme ] [tnmminy ] frone =] [rone jﬁﬂ\TJ s _"EE'W

1.6. ECG Information Bar | Patiert; Mi | Date: e 03 2001 | Time: 01:28:26 Pw | Duratiar; D0k00M:00s |5ampnn¢ Rsfe: 1uqsps

» Displays information about the current L

ECQG, including patient name, date, time,
duration of recorded ECG, and device
sampling rate. JL“ «f[ﬁ JL“

1.7. Real-Time Display
» Displays the incoming ECG signal. /

1.8. Sweep Line
» Shows position on trace of current instant
of incoming ECG signal. «fV JV Jtr
]
1.9. Show / Hide Sweep Line / |
» Toggles sweep line on and off.

1.10. Configure Device i)
» Opens the ECG device configuration
dialog, where device drivers can be
changed for different devices.

1.11. Set Recording Duration

» Type in a time after which recording will
be automatically stopped. Zero value
indicates indefinite (manually controlled)
recording.
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Editing tools

1. Guide to editing functions of the ECG Viewer.
U See sections following for details on using

these tools.

1.1. Add Vertical Calipers

» Makes the cursor a tool for adding vertical
calipers, a measuring tool that can be
placed anywhere on an ECG to take a
vertical (voltage) measurement.

1.2. Add Horizontal Calipers
» Makes the cursor a tool for adding
horizontal calipers, a measuring tool that
can be placed anywhere on an ECG to take

a horizontal (time) measurement on the
ECQG strip (e.g., QR interval).

1.3. Add Beat Calipers

» Makes the cursor a tool for adding a beat
caliper marking the P, Q, R, S, and T
waves and calculating intervals.

1.4. Zoom In/ Out

» Makes the cursor a tool for zooming in
(left click) and out (right click) on the ECG

display.
1.5. Point Click 8 Mo Ayt £CG - raven, Babiy \ \ \ \ \ [ [BX]
4 Makeg the cursor a tool for ppint—and—click oesw B Bfsms BomwEie: Hoe EEDEEE Q
SeleCthl’l Of 1tems on ECG dlSplay, Patient: Braven, Bobby Date: 124052002 Time: 11:33:43 AM Duratior: 00:01:04 ampling Rate: 250shs

1.6. Add Text Comment

» Makes the cursor a tool for adding a block
of text that can be placed anywhere on an
ECG to explain, query, or draw attention to
some part of it. e

1.7. Add/Edit Sample S e s 1 g v e et s s
» Makes the cursor a tool for adding or
editing an ECG sample, a marker that

highlights and selects a portion of an ECG.

1.8. Add/Edit Mask
CHT

» Makes the cursor a tool for adding or P 5
editing a mask, a marker that masks off a SLATET S > ERERE
portion of the ECG that should be
disregarded (e.g., line noise recorded in a
transtelephonic ECG).

1.9. Open Editing Screen
» Accesses the part of the ECG record that
contains context information (e.g.,
receiving technician, patient symptoms,
ECG report options).
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Reviewing ECG sampling
1. Taking a sample.

1.1.
4

1.2.

1.3.

1.4.

Click Add/Edit Samples.

Pointer changes to g:-c:

\
aEE

Point at beginning of desired portion of

Cre Strip

mmw ngr2002

A =lfesmms < [rommmy <|[none ~][40kz Lﬂ@ﬂ % @l | T|2< &_EJ

Time: 2:57:34 PM Durstion: 00:00:19 Sampling Rate: 250sps

ECG trace and click on it.

A 8-second sample, centered where you

Yos

clicked, is created. The sampled part of the
trace changes colour.

The sample size (6 or 8 seconds) is set in
the ECG Preferences.

ransmitter ID 73003504C6

vent # 2 - Tue Mo 19 14:57:34 2002

Pre€vent 5 5 PostEvert 10 = Flags 1
———

i

& sec

16 sec

24 sec
32 sec

i

40 sec

anuEl
{ctivation|

AL AT A AL

Sample ECG

Sample options menu appears.

Choose a sample option:

1.3.1. To make the sample longer, click
8sec, 16sec, 24sec, 32sec, and
40sec.

1.3.2. To place a label on the sample,
click a choice or to have no label,

click No label.
Size or label applied accordingly.

Marmal Sinus Rhythm
Ventricular Arrhythmia
Sinus Tachycardia
Sinus Bradycardia
Atrial Fibrillation
Pause
ST Change

® Molabel

CHT «
>

00000000 4k 00:00:09.18;

2. Repositioning a sample.

2.1. Click Point Click. : . _
= s oo - B
Ore Strip = =lfesmms ~[rommimy <|[none ][s0rz j’@ﬂ [ e _]_EJ
Patiert: Braven, Bobby Date: 1119:2002 Time: 2:57:34 PW Duration: 00:00:19 Sampling Rate: 250sps
2.2. Position cursor over the sample end-bar. 1
» Cursor changes to {b
2.3. Click and hold mouse button. 3 i
» Selected sample is highlighted with heavier T OO Aol
graphlc hl’le. PreEvent 5 s PostEvert 10 s Fs 1 'l " 'l n ’l
2.4. Drag right or left to desired position.
2.5. Release mouse button.
» Sample is left at new position.
CHT «
< >
00:00:0000 4 v 00:00:09.18
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3. Deleting a sample.

3.1. Click Point Click.

6) Arrhythmia ECC

1biry - Mol

[5]x)

Patient: Braven, Bobby

Dabe: 1101952002

One Strip = =fsmms < [tommimy <|[vone +|[40kz

Time: 2:57:34 PM

IR x| \[% QU] | T(></8 |

Duration: 00:00:19 Sampling Rate: 250sps

3.2. Position cursor over sample end-bar.

» Cursor changes to {b

3.3. Click mouse button.

» Selected sample is highlighted with heavier
graphic line.

3.4.
» Sample is removed.
» ECG trace in formerly sampled area reverts

Press Delete key on keyboard.

ransmitter ID 7S003804CH
Pre€vent 5 5 PostEvent 10 s Flags 1
Yy

to normal colour. e ! 'Cf%': v
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Horizontal calipers

1. Taking a horizontal caliper measurement.

1.1. Click Horizontal Caliper Measurement.

» Pointer changes to

\ - [ax]|

[one strip
Petient: Br:

jm‘?ﬁmmis | [ommmy =|[wone ~][a0mz j’@ﬂ ’T Q| | E| T|3< ﬁJ_EJ

awen, Bobhby Date: 11192002 Time: 2:57:34 P Durgtion: 00:00:19 Sampling Rate: 250zps

1.2. Point at beginning of measurement.
1.3. Click and hold mouse button.

» Caliper appears.
1.4. Drag cursor to end of measurement.

» Caliper length and label change with
changing position.

1.5.
» Measurement units/label menu appears.

Release mouse button.

wert # 2
reEvent

| ransmitter ID TS003504CH

i

- Tue Mov 19 14:57:34 2002

fanual
Pctivatiol
£ 5 PostEvert 10 = Flags 1
L H—J wb | wulJ o ;ML/ b

1.6. Click on desired units or label.
» Label changes accordingly.

» ECG Viewer remains in caliper mode until
another mode is selected.

LAY N = AT CHT v
k T Y e v ¥
"
ot 00000000 4 b O0.00:08.18
o
13 el

2. Repositioning a horizontal caliper.

2.1. Click Point Click.

2.2. Position cursor over any part of caliper

measurement except endpoints.

\

| aEE|

Cne Strip

Patiert: Braven, Bobly

\
RQWHITXNE

Durstion: 00:00:19 Sampling Rate: 250sps

O | e | | e 23 R

Date: 111952002 Time: 2:57:34 PM

» Cursor changes to {b

2.3. Click and hold mouse button.
2.4. Drag to desired new position on trace.
2.5. Release mouse button.

» Caliper is left at new position.

ransmitter ID 750038048

vent # 2 - Tue Nov 19 145734 2002

PreEvent 5 = PostEvent 10 = Flags 1
]

f

el
e ptivation

CHT ~
>

00000000 4k 00:00:09.18;
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3. Deleting a horizontal caliper measurement.

3.1. Click Point Click.

>

- [5[%)

One Strip

A lfesmmis ~{frammmy <fnore ~][srz <] 1]

3.2. Position cursor over any part of caliper

measurement except endpoints.

atiert-Brrer Bt

Time: 2:57:34 PM

Bt 71972002

\
5

Duration: 00:00:19

Q|| Z| T|=< 8| E|

Sampling Rate: 230sps

» Cursor changes to {b

3.3. Click mouse button.
» Caliper label is underlined to indicate it is
selected.
3.4. Press Delete key on keyboard.

» Caliper measurement is removed.

Vertical calipers

ransmitter ID 75003804 C6

Pre€vent 5 5 PostEvert 10 5 Flags 1
———2

vent # 2 - Tue Mov 19 14:57:34 2002

CHT «
>
00:00:09.18;

0on0:0000 4k

4. Repositioning a vertical caliper.

O Same as horizontal caliper. See
Repositioning a horizontal caliper above.

5. Deleting a vertical caliper measurement.
O Same as horizontal caliper. See Deleting a

horizontal caliper above.
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Beat complex callipers

WARNING In the areas where Beat Complex Calipers are used, the measurements that are taken are approximate
and do not analyze the waveform. Calipers placed by this tool can be adjusted accordingly.

1. Making a beat complex caliper measurement.

1.1.

Click Add Beat Complex Calipers.

) [single Lesa = =l[zsmme =l [iommny 2] [vone =] [rone j]ﬁﬂ [ @ ml lol| Z| T]2<| 18 El
} POlnter Changes to | Patiert: Able, Alfred Dste: 2003 2pr-15 Time: 10:56:18 &M Puratior: 00:01:01 Sampling Rate: 100sps .
1.2. Line up the heavy line at the center of the — Il
pointer with the peak of the R wave in a J\ﬁ J‘p Jﬂ J\(
QRS complex.
1.3. Click.
»  Beat complex caliper is placed with i
markers (vertical lines) automatically
aligned with the following features ‘ ‘ :
X Sngelead =l =|[2smmis <] [10mmimy =|[wone  =|[more = ||EH I Qi W Z|T|=|8|E
detected in the CompleX: Lsment: bl Alfred l__“ Date: 2|003-Apr-15 I Time: 10 5!3:18 M buratglou 010 W
> onset of P wave [RR30.0 bpm, PR0.180 Sec, QRS 0.150 Sec, OT 0.340 Sec, QTc 0.240 Sec | ~|
» PQ boundary
> peak of R wave (labelled “R” at  Lu w\p }
=
top of marker) =
» ST boundary
» endof T wave =1
» A beat complex measurements bar
appears at the top of the ECG display,
showing: J‘p JM JM M_
» RR measurement (bpm)
» PR interval (s)
» QRS duration (s) [ iﬁ'
} QT interval (S) [ (00001030 4 [ 0002602
> QTc interval (s) [ RR 30.0 bpm. PR 0.180 Sec. QRS 0.150 Sec, QT 0.340 Sec, QTc 0.240 Sec |
% Zoomed-in view of a beat complex caliper. ] N \Rp \Rp
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2. Locking or unlocking a beat complex caliper.

7

¢ Markers in a beat caliper can be
repositioned if and only if it is unlocked.

2.1. Click Point and Click.

Single Leart =l =lfzsnmis =[frommmy <f[none =][rone jﬁﬂ & QIm] el IIT <] EI
Patient: able, Alfred Pate: 2003-Apr-15 hime: 105610 Abd 5ura1ion 00:01:01 Eampling Rate: 100sps

2.2. Position cursor over a marker (vertical [RR30.0bpm, PROD.180 Sec, QRS 0.150 Sec, O 0.340 Ses, QT 0.240 Sec | =1
line) in the caliper (P onset shown in this
example). il w‘w
»  Cursor changes to +—. e
K Delete
2.3. Right-click mouse button. | s it

g )
4 Pop_up menu appearS./
2.4. Click Lock or Unlock.
» Beat complex caliper is locked or JV “-IL‘ J‘/‘ J\ﬂ——

unlocked accordingly.

] — illl

[ I [oooo1030  « v Ono02502

3. Repositioning a marker in a beat complex caliper.

o

% Markers in a beat caliper can be
repositioned if and only if it is unlocked
(see item 2 above).

3.1. Click Point and Click.

Sngelead ||l =||zsmms =|[i0mmimy <][wene  =|[Mene  ~|JBH L] e 1 e o

Patiert: Akle, Alfred Date: 2003-Apr-15 [Time: 10:86:18 AM Duration; 00:01:01 {Sampling Rete: 100sps

3.2. Position cursor over a marker (vertical [ RR30.0 bpm, PR 0.180 Sec, ORS 0.150 Sec, 0T 0.340 Sec, QTc 0.240 Sec | =)

line) in the caliper (P onset shown in this

le). A /
R example «J‘/\

Cursor changes to +—*.

3.3. Click and hold mouse button.

» Beat complex measurements bar appears: 1 ™
3.4. Drag marker to desired new position on JV JM Jn
trace. e
3.5. Release mouse button.
Marker is left at new position. i
KT E— _'l_I
Beat complex measurements change | e T TR N T i

automatically as you drag.
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4. Deleting a beat complex caliper.

4.1. Click Point and Click.

ISlngIe Lead j|u j|25 mmis j|mmmrmvj|Nune j|Nune

S % QU L Z| T[> B[ El

Petiert: Able, Alfred Date: 2003-Apr-15 Time: 10:56:16 AM

5ura1ion 00:01:01 Eampling Rate: 100sps

4.2. Position cursor over a marker (vertical
line) in the caliper (P onset shown in this
example).

»  Cursor changes to +—+.

4.3. Click mouse button.

| AR 30.0 bpm, PR 0.180 Sec, QRS 0.150 Sec, QT 0.340 Sec, QTc 0.240 Sec ‘ =

o /J» e

»  Beat complex measurements bar appears:

4.4. Press Delete key on keyboard.
»  Caliper measurement is removed.

Text comments

1. Adding text comments.

1.1. Click the T button to add Text Comments.

» Pointer changes to I

1.2. Position pointer where you wish to place
text comment and click.

» Text box appears at cursor position.
1.3. Enter comments.

1.4. Click anywhere outside of text box.
» Text box closes.

» Text remains superimposed on ECG trace.

i

] E— illl

00001030 4 00:00; 26,02

w9 (27) Arshythmia ECG - Braven, Bobby - Not Edited

EEX
File Report Took Help
[one strip ~llem =25 mme <] [1ommmy < |vene ~|[eorz <] BB I] [k QMW E| T 2<| B E|

Patient: Braven, Bobby Date: 1141952002 Time: 2:58:25 P Duration: 00:00:18 Sampling Rate: 250508

Je-E

MWM

CHT
< >
000007 .71 “» 00:00:18.90/
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2. Repositioning a text comment.

2.1. Click Point Click.

2.2. Position cursor over any part of text.

» Cursor changes to {b
2.3. Click and hold mouse button.
2.4. Drag to desired new position on trace.

2.5.
» Text is left at new position.

Release mouse button.

™ (27) Arshythmia ECG - Braven, Babby - Not Edited
File Report Tools Help

et w|[2smms +[10mminy -] [mone

Date: 114972002

Jone strip
petient. Braven, Bobb,

|annz

Time: 2.58.25 Pi
)

i

Dwration; 00:00:19

& Ol k| [ T[2<| B E

Sampling Rate: 250sps

Sample ECG

Comment

00000729 4

CHT ~
>
00.00:16.48

3. Editing the content of a text comment.

3.1. Click Point Click.

3.2. Position cursor over any part of text.

» Cursor changes to {b

3.3. Right-click mouse button.
» Pop-up menu appears.

3.4. Click Edit.
» Text box opens for editing.

3.5.

3.6.
» Text box closes.

» Revised text remains superimposed on
ECG trace.

Edit text.

Click anywhere outside of text box.

M| (27) Arrhythmia ECG - Braven, Bobby - Hot Edited
File Report Tools Help

[one strip

~[er <][zsmmis ][iommimy +none +|[aon: | 1|

Patiert: Braven, Bobhby Date: 114852002

Time: 2:56:25 PN

Duration: 00:00:13

Q] X T[] ] E

Sampling Rate: 250sps

B=E3

Sample ECG

Comment

00000729 4 (»

CHT «
>
00.00:16.48
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4. Deleting a text comment.

4.1. Click Point Click.

m (27) Arrhythmia ECG - Braven, Bobby - Not Edited FEX
File Report Tools Help

Jone strip et ~||zsmme = [10mmmy | [Mone ][40 v j@ﬂ & [ Q | 1| | T]2<| E

Patient: Brawven, Bobhby Date: 114872002 Time: 2:58:25 P Duration: 00:00:18 Sampling Rate: 250sps

4.2. Position cursor over any part of text. -

» Cursor changes to {b Sams ECB

4.3. Click mouse button.

» Text is underlined to indicate it is selected.. ot
4.4. Press Delete key on keyboard.

» Text comment measurement is removed.

CHT «
< 3
0000729 4 b 00001648

Editing the ECG record

Viewing and/or editing the ECG annotation.
1.1. Click Open Editing Screen.

B (27) Arrhythmia ECG - Braven, Bobby - Not Edited

} ECG dlalog OpenS. File Report Tooks Help
One Strip w|[ert ~[[2smmie ~][10mminy ~|[none = ([4onz j’@ﬂ & [Q Il 1| E| T |2<] B
Patiert: Braven, Bobby Dater 11/19/2002 Titme: 2:58:25 P Duration: 00:00:19 Sampling Rate: 250zps
Sample ECG
1.2. View and/or edit information on ECG -
. . 1 (0) Arrhythmia ECG - Braven, Bobby - Edited/Not Sent X]
dialog. To review ’measgremen‘Fs taken or e
to add Technician’s findings click on the — =
4 Fl:cd\r:;:lans v | Editing Tech.: |RF &7
Edlt Tab b, ~ ~ Append Rate: [83 to [110 e
. . . . Normal Sinus Rhythm PR [15 to |18
1.3. To view or edit the patient record, click -
Patient.... or @ wlmE
) E\ehent.. 0k | Cancel | gopk | Hep |
1.4. Click OK. - 1
} ECG dlalog Closes. 00000729 4 b OOODIEA4E
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General troubleshooting

If you are having trouble recording ECGs, consult the For troubleshooting procedures for other problems,
manual section that follows this one in case you are including other ECG recording problems, please see the
encountering a certain hardware-related problem detailed GEMS Lite online Help.

there.

GEMS Lite Manual Rev. 1.0 / 29-Nov-2004



A certain hardware problem that prevents ECG recording

You may encounter a problem when trying to record an sound card. The information below helps you determine
ECG, particularly if you have just installed GEMS Lite. whether you are experiencing this problem and gives you
This problem occurs if you have hardware on your information on how to resolve it.

computer—usually a modem—that takes control of the

1. Check whether you are experiencing this problem.

1.1. Were trying to record a new ECG?

®

s To record a new ECG, either

you clicked New > Arrhythmia/12 Lead
ECG, then clicked OK on the Arrhythmia
ECG form, or

you clicked New > TTM Pacing ECG.

If yes, continue to the next step.

ECG Preference i |

Specify ane of the follawing (based on
type of ECG devicel:

If no, you were not experiencing this
particular problem. Check the online Help
for further troubleshooting procedures.

1.2. Did this form appear instead of the ECG

" Dovnload events from an event recorder

& K 2

e |3 the device you wish to access
k4 connected to a remote computer an
the network:

Viewer? I Remots connestion
s See page 30 for an example of the ECG
Viewer.
» If yes, continue to the next step. ek [ Hets | Concel

» Ifno, you were not experiencing this
particular problem. Check the online Help
for further troubleshooting procedures.

2. Call CardioComm for support.

2.1. Please call the Help Desk at 877-744-1122
ext. 3. Tell the customer support technician
that you believe are having sound card
problems.

» The customer support technician will
verify the problem with you and lead you
through a step-by-step procedure for
resolving it.
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Before you contact us

When an error message appears, or the program stops
responding or quits unexpectedly, please do these things
first.

1. Write down any error message that appears. Try to
include all information in the message, even if it
looks like gobbledygook.

2. Close all applications that are currently running.

U Important: Save any unsaved data before quitting
your applications.

3. If'the system seems normally responsive, restart your
computer:
3.1. Click Start, then click Shut Down...
4 The Shut Down Windows dialog appears.
3.2. Click Restart.
3.3. Click OK.

4 The computer will take a few minutes to
restart. If nothing happens after an extended
time, you may need to turn the power off, wait
a few moments and turn the power back on.
Windows may start in safe mode at this time,

and it is best to follow the above procedure to
restart again in normal mode.

4. Ifthe system is "hung" and does not seem to respond
to commands (mouse clicks, keystrokes):
4.1. Press Ctrl+Alt+Delete (i.c., press all three keys
simultaneously).
4 Windows NT Security dialog appears.
4.2. Click Task Manager....
4 Windows NT Security dialog closes.
4 Windows NT Task Manager dialog appears.
4.3. Scroll through the list of programs on the
Application tab. You are looking for program
names followed by “not responding.” These

indicate programs that have stopped
responding to the system (and you).

4.4. For each such non-responding program, click on
it and then click End Task.
4 Not Responding dialog appears.
4.5. Click End Task.
4 Normally, the offending program is shut
down and your system is back in your hands.
4.6. Close the Task Manager.

If you have been able to shut down all non-
responding programs and the system appears
normally responsive, return to step 2 above.

If the system remains unresponsive:
6.1. Press Ctrl+Alt+Delete (i.e., press all three keys
simultaneously).

4 Windows NT Security dialog appears.

6.2. Click Shutdown....
4 Windows NT Security dialog closes.
4 Shutdown Computer dialog appears.
6.3. Click Restart.
6.4. Click OK.

4 Shutdown Computer dialog appears.

4 The computer should shut down and restart.
This will take a few minutes. If nothing
happens after an extended time, you may need
to turn the power off, wait a few moments and
turn the power back on. Windows may start in
safe mode at this time, and it is best to follow

the above procedure to restart again in normal
mode.

6.5. If your computer system still does not respond,
press the Reset button on the front panel of
your computer.

Start GEMS Lite again.

If problems persist, please contact CardioComm
Solutions Inc. Help Desk at 877-744-1122 ext. 3.
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